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Before You Begin

This Getting Started Guide provides instructions for installing, setting up, and starting
the Sun™ ONE Studio 5, Standard Edition integrated development environment
(IDE). This book is designed for both system administrators and developers who
install software. You should be experienced with basic installation procedures on
your platform.

Screen shots and commands entered at the command line vary slightly from one
platform to another. For example, a Microsoft Windows command might look like
this:

A UNIX® command might look like this:

Before You Read This Book
You should be familiar with installing and uninstalling software products on the
platforms you choose to use with this release of the Sun ONE Studio 5 IDE. You
need familiarity with system administration commands, such as:

■ su, xhost, pkginfo, pkgadd, and pkgrm utilities in the Solaris™ Operating
System (Solaris OS)

■ Add/Remove Program utility on Microsoft Windows systems

■ rpm command in the Linux environment

c:>cd MyWorkDir\MyPackage

% cd MyWorkDir/MyPackage
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If you are unsure about the system administration commands for your operating
system, contact your system administrator for assistance with the instructions in this
guide.

Before using this IDE, you should also be familiar with the following subjects:

■ Java™ programming language

■ Enterprise JavaBeans™ (EJB™) technology concepts

■ Java™ Servlet API syntax

■ Syntax for drivers that support the JDBC™ API

■ HTML syntax

■ JavaServer Pages™ technology syntax

■ How to use JDBC databases

■ Java™ 2Enterprise Edition (J2EE™) application assembly and deployment concepts

■ Web Services

■ Using application servers such as Sun™ ONE Application Server 7, Standard
Edition

Using the Sun ONE Studio 5, Standard Edition IDE successfully requires a
knowledge of J2EE™ concepts, as described in the following resources:

■ Java 2 Platform, Enterprise Edition Blueprints
http://java.sun.com/j2ee/blueprints

■ Java™ 2 Platform, Enterprise Edition Specification
http://java.sun.com/j2ee/download.html#platformspec

■ The J2EE Tutorial
http://java.sun.com/j2ee/tutorial

■ Java Servlet Specification Version 2.3
http://java.sun.com/products/servlet/download.html#specs

■ JavaServer Pages Specification Version 1.2
http://java.sun.com/products/jsp/download.html#specs

Familiarity with the Java API for XML-Based RPC (JAX-RPC) is helpful. For more
information, see this web page:

http://java.sun.com/xml/jaxrpc

Note – Sun is not responsible for the availability of third-party web sites mentioned
in this document and does not endorse and is not responsible or liable for any
content, advertising, products, or other materials on or available from such sites or
resources. Sun will not be responsible or liable for any damage or loss caused or
alleged to be caused by or in connection with use of or reliance on any such content,
goods, or services available on or through any such sites or resources.
8 Sun ONE Studio 5, Standard Edition Getting Started Guide • June 2003

http://java.sun.com/j2ee/blueprints
http://java.sun.com/j2ee/download.html#platformspec
http://java.sun.com/j2ee/tutorial/1_3-fcs/index.html
http://java.sun.com/products/servlet/download.html#specs
http://java.sun.com/products/jsp/download.html#specs
http://java.sun.com/xml/jaxrpc


Typographic Conventions

Related Documentation
Sun ONE Studio documentation includes books delivered in Acrobat Reader (PDF)
format, release notes, online help, readme files for example applications, and
Javadoc™ documentation.

Documentation Available Online
The documents described in this section are available from the docs.sun.comSM

web site and from the documentation page of the Sun ONE Studio Developer
Resources portal at http://forte.sun.com/ffj/documentation.

The docs.sun.com web site (http://docs.sun.com) enables you to read, print,
and buy Sun Microsystems manuals through the Internet. If you cannot find a
manual, see the documentation index that is installed with the product on your local
system or network.

Typeface Meaning Examples

AaBbCc123 The names of commands, files,
and directories; on-screen
computer output

Edit your .cvspass file.
Use DIR to list all files.
Search is complete.

AaBbCc123 What you type, when contrasted
with on-screen computer output

> login

Password:

AaBbCc123 Book titles, new words or terms,
words to be emphasized

Read Chapter 6 in the User’s Guide.
These are called class options.
You must save your changes.

AaBbCc123 Command-line variable; replace
with a real name or value

To delete a file, type DEL filename.
Before You Begin 9
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■ Release notes (HTML format)

Available for each Sun ONE Studio edition. Describe last-minute release changes
and technical notes.

■ Sun ONE Studio 5, Standard Edition Release Notes - part no. 817-2337-10

■ Getting Started guides (PDF format)

Describe how to install the Sun ONE Studio integrated development environment
(IDE) on each supported platform and include other pertinent information, such
as system requirements, upgrade instructions, application server information,
command-line switches, installed subdirectories, database integration, and
information on how to use the Update Center.

■ Sun ONE Studio 5, Standard Edition Getting Started Guide - part no. 817-2318-10
■ Sun ONE Studio 4, Mobile Edition Getting Started Guide - part no. 817-1145-10

■ Sun ONE Studio 5 Programming series (PDF format)

This series provides in-depth information on how to use various Sun ONE Studio
features to develop well-formed J2EE applications.

■ Building Web Components - part no. 817-2334-10

Describes how to build a web application as a J2EE web module using JSP
pages, servlets, tag libraries, and supporting classes and files.

■ Building J2EE Applications - part no. 817-2327-10

Describes how to assemble EJB modules and web modules into a J2EE
application and how to deploy and run a J2EE application.

■ Building Enterprise JavaBeans Components - part no. 817-2330-10

Describes how to build EJB components (session beans, message-driven beans,
and entity beans with container-managed persistence or bean-managed
persistence) using the Sun ONE Studio EJB Builder wizard and other
components of the IDE.

■ Building Web Services - part no. 817-2324-10

Describes how to use the Sun ONE Studio IDE to build web services, to make
web services available to others through a UDDI registry, and to generate web
service clients from a local web service or a UDDI registry.

■ Using Java DataBase Connectivity - part no. 817-2332-10

Describes how to use the JDBC productivity enhancement tools of the Sun
ONE Studio IDE, including how to use them to create a JDBC application.

■ Sun ONE Studio tutorials (PDF format)

These tutorials demonstrate how to use the major features of Sun ONE Studio 5,
Standard Edition:

■ Sun ONE Studio 5 Web Application Tutorial - part no. 817-2320-10

Provides step-by-step instructions for building a simple J2EE web application.
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■ Sun ONE Studio 5 J2EE Application Tutorial - part no. 817-2322-10

Provides step-by-step instructions for building an application using EJB
components and web services technology.

■ Sun ONE Studio 4, Mobile Edition Tutorial - part no. 816-7873-10

Provides step-by-step instructions for building a simple application for a
wireless device, such as a cellular phone or personal digital assistant (PDA).
The application you build is compliant with the Java 2 Platform, Micro Edition
(J2ME™ platform) and conforms to the Mobile Information Device Profile
(MIDP) and Connected, Limited Device Configuration (CLDC).

You can also find the completed tutorial applications at:
http://forte.sun.com/ffj/documentation/tutorialsandexamples.html

Online Help
Online help is available in the Sun ONE Studio IDE. You can open help by pressing
the help key (F1 in Microsoft Windows and Linux environments, Help key in the
Solaris environment), or by choosing Help → Contents. Either action displays a list
of help topics and a search facility.

Examples
You can download examples that illustrate a particular Sun ONE Studio feature, as
well as completed tutorial applications, from the Sun ONE Studio Developer
Resources portal at:

http://forte.sun.com/ffj/documentation/tutorialsandexamples.html

The site includes the applications that are used in this document.

Javadoc Documentation
Javadoc documentation is available within the IDE for many Sun ONE Studio
modules. Refer to the release notes for instructions on installing this documentation.
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Documentation in Accessible Formats
The documentation is provided in accessible formats that are readable by assistive
technologies for users with disabilities. You can find accessible versions of
documentation as described in the following table.

Contacting Sun Technical Support
If you have technical questions about this product that are not answered in this
document, go to:

http://www.sun.com/service/contacting

Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your comments and
suggestions. Email your comments about this book to Sun at this address:

docfeedback@sun.com

Please include the part number (817-2318-10) of this document in the subject line of
your email.

Type of Documentation Format and Location of Accessible Version

Books and tutorials HTML at http://docs.sun.com

Mini-tutorials HTML at
http://forte.sun.com/ffj/tutorialsandexamples.html

Integrated example
readmes

HTML in the example subdirectories of
s1studio-install-directory/examples

Release notes HTML at http://docs.sun.com
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CHAPTER 1

Preparing for Installation

This chapter contains information that you need before you install the Sun™ ONE
Studio 5, Standard Edition IDE. This release of Sun ONE Studio includes Sun™ ONE
Application Server 7, Standard Edition and PointBase Server 4.2 Restricted Edition
(PointBase). The installation of these products with the Sun ONE Studio installer
results in an integrated enterprise level tool for developing and deploying
applications written in the Java™ programming language using J2EE concepts.

This chapter covers:

■ “Overview of the Installation Process” on page 13
■ “Supported Platforms” on page 14
■ “System and Disk Space Requirements” on page 15
■ “Verifying Your J2SE Platform” on page 17
■ “Supporting Previous Software Releases” on page 19
■ “Having the Correct User Privileges” on page 19

Overview of the Installation Process
This section describes the general process for installing and configuring the Sun
ONE Studio IDE on your system.

TABLE 1-1 Overview of IDE Installation and Configuration

Task For Instructions

Verify that your platform is supported. “Supported Platforms” on page 14

Verify the system and disk space requirements. “System and Disk Space
Requirements” on page 15

(Solaris only) Install the necessary Solaris patches. See “Applying the Solaris 8 OS
Patches” on page 29
13



Supported Platforms
The Sun ONE Studio 5, Standard Edition IDE is supported on the following
platforms:

■ Microsoft Windows 2000 Professional
■ Microsoft Windows XP Professional
■ Red Hat Linux 7.2
■ Solaris™ 9 OS (32-bit/64-bit, UltraSPARC® III)
■ Solaris™ 8 OS (32-bit/64-bit, UltraSPARC® III)

Verify that you have access to the required verion
of the J2SE platform.

“Verifying Your J2SE Platform” on
page 17

Determine if you have the correct permissions to
install the IDE.

“Having the Correct User Privileges”
on page 19

Determine if you want to keep your previous
version of the IDE.

“Supporting Previous Software
Releases” on page 19

Install the IDE. • “Installing the IDE (Microsoft
Windows Systems)” on page 21

• “Installing the IDE (Linux Systems)”
on page 25

• “Installing the IDE (Solaris OS)” on
page 29

Set up your initial IDE environment. “Setting Up the IDE” on page 37

(Optional) Confirm configuration of Sun ONE
Application Server 7.

“Using Sun ONE Application Server
With the IDE” on page 43

(Optional) Validate your installation of the IDE by
creating a simple J2EE application.

“Validating Your IDE Installation” on
page 55

(Optional) Configure PointBase. “Using Databases With the IDE” on
page 59

(Optional) Configure your WebLogic Server
environment.

“Using BEA WebLogic Servers With
the IDE” on page 67

TABLE 1-1 Overview of IDE Installation and Configuration (Continued)

Task For Instructions
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System and Disk Space Requirements
TABLE 1-2 lists the system requirements needed to install a minimum configuration
on any of the supported platforms.

These are general guidelines. Your requirements might vary depending on which
additional software you have installed for use with the Sun ONE Studio.

Disk Space Requirements
The main factor in determining how much installation disk space you need is to
know if the Sun ONE Studio IDE installer will install the IDE and the Sun ONE
Application Server or just the IDE. The IDE installer looks for an existing installation
of Sun ONE Application Server 7 and PointBase Server 4.2 Restricted Edition on
your system.

■ If the installer detects an existing installation of the Sun ONE Application Server
7 and PointBase on your system, then only the Sun ONE Studio IDE is installed.

■ If the installer detects an existing installation of the Sun ONE Application Server
7 on your system but not PointBase, the installer displays a message suggesting
that you uninstall your existing Sun ONE Application Server 7 and rerun the IDE
installer to install a new Sun ONE Application Server 7 that is tightly integrated
with the IDE and includes PointBase.

■ On a Solaris 9 update 2 OS, you have the option to install a second copy of Sun
ONE Application Server 7 that is tightly integrated with the IDE and contains the
PointBase Server.

TABLE 1-2 Sun ONE Studio 5, Standard Edition System Requirements

Supported Platforms Minimum Configuration Recommended Configuration

Windows 2000, Windows
XP

Pentium III, 500 MHz
512 MB RAM

Pentium III, 1GHz
768 MB RAM

Red Hat Linux 7.2 Pentium III 500 MHz
512 MB RAM

Pentium III, 1GHz
768 MB RAM

Solaris 8, Solaris 9 operating
systems (32-bit/64-bit,
UltraSPARC® platform)

Ultra™ 60, 450 MHz
512 MB RAM

Sun Blade™ 1000, 750 MHz
1 GB RAM
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The PointBase Server 4.2 Restricted Edition is the default database provided with the
IDE. The database is provided so you can start immediately to build and deploy
applications. You need this database to use the Sun ONE Studio examples and
tutorials.

Temporary Space Requirements

Running the installer requires sufficient temporary space to unpack the installation
files.

■ On UNIX® systems, the installer uses the /tmp or the /var/tmp directory.

■ On a Microsoft Windows system, the installer uses the directory as specified by
the user variable TEMP in the System Properties settings.

Space Requirements by Platform

The space requirements are described in TABLE 1-3 for Microsoft Windows, TABLE 1-4
for Linux systems, and TABLE 1-5 for Solaris OS systems..

TABLE 1-3 Disk Space Requirements for Microsoft Windows

Directory
Sun ONE Studio plus Sun ONE
Application Server 7

Sun ONE Studio
only

s1studio-install-directory 450 MB 150 MB

temporary space as
defined in user variable
TEMP found in System
Properties

190 MB 190 MB

TABLE 1-4 Disk Space Requirements for Linux OS

Directory
Sun ONE Studio plus Sun ONE
Application Server 7 Sun ONE Studio

s1studio-install-directory 485 MB 150 MB

/tmp (temporary space) 200 MB 200 MB

/etc/opt 2 MB n/a

/var/opt 20 MB n/a

/opt/imq 8 MB n/a
16 Sun ONE Studio 5, Standard Edition Getting Started Guide • June 2003



Verifying Your J2SE Platform
To install the Sun ONE Studio IDE you must have one of the following:

■ At least the J2SE, version 1.4.1_02 platform installed locally

■ Network access to the path in which at least the J2SE version 1.4.1_02 platform is
installed

Note – To maximize runtime performance, the J2SE platform should be installed on
and accessed from your local system.

The recommended J2SE platform version is included on the product companion CD-
ROM. You can also find J2SE platform versions at
http://java.sun.com/j2se/downloads.html.

At this site, you can access current versions as well as archived J2SE platform
versions. Sun maintains the download site for previously released versions of the
J2SE platform and related products that have completed the end-of-life process and
are no longer covered by standard support contracts. These downloads are made
available as a courtesy to developers to assist in problem resolution. Look for the
section titled “Download Archived Releases” or the Archived Downloads link.

TABLE 1-5 Disk Space Requirements for Solaris OS

Directory
Sun ONE Studio plus Sun ONE
Application Server 7 Sun ONE Studio

s1studio-install-directory 550 MB 150 MB

/var/tmp (temporary space) 190 MB 190 MB

/usr 76 MB n/a

/etc/opt 4 MB n/a

/var/opt 30 MB n/a
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▼ To Determine Your Current J2SE Platform
Version
■ Identify which J2SE platform version is available to your system by typing the

following command at a command line.

The output looks similar to the following:

If you do not have at least the J2SE version 1.4.1_02 platform available to your
system, you must install the supported J2SE version 1.4.1_02 platform.

Depending on how you have your PATH environment variable set, the java -version
command may not return complete results. If this command does not return the
correct version and you know you have a suitable J2SE version on your system, use
the command line option, -is:javahome, to specify the the path. See Appendix D
for details.

▼ To Install the J2SE Version 1.4.1_02 Platform

Note – (Solaris only) Prior to installing the J2SE platform, you must ensure that you
have installed the full set of required patches. See “Applying the Solaris 8 OS
Patches” on page 29.

1. Obtain the appropriate platform-specific installer file from
http://java.sun.com/j2se/downloads.html or from the Sun ONE Studio 5
companion CD.

TABLE 1-6 lists the installer file names for each supported platform.

2. Install the J2SE version 1.4.1_02 platform on your system.

java -version

java -version
java version "1.4.1_02"
Java(TM) 2 Runtime Environment, Standard Edition (build 1.4.1_02-
b02)
Java HotSpot(TM) Client VM (build 1.4.1_02-b02, mixed mode)
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Installation instructions can be found on the web site. If you have the product CDs,
you can find the installation instructions on the companion CD in the same directory
as the J2SE software installer file.

Supporting Previous Software Releases
To upgrade your previous version of the Sun ONE Studio IDE to Sun ONE Studio 5,
Standard Edition, you must do one of the following:

■ To keep your previous version of the IDE, identify a different directory in which
to install the Sun ONE Studio 5 software when prompted during installation.

To use the same installation directory as the previous IDE version, first uninstall
the previous version of the IDE prior to installing Sun ONE Studio 5 software. See
the Getting Started Guide for your currently installed version of the IDE.

■ To keep your current IDE user settings, specify the location of your current user
directory when prompted during the initial IDE setup on the Settings Import
wizard. See “Setting Up the IDE” on page 38.

Having the Correct User Privileges
On a Solaris or Linux system, you must have superuser (root) privileges to install a
standard installation of this software. A standard installation includes Sun ONE
Studio and Sun ONE Application Server 7 with PointBase. On a Linux system, if you
have an existing installation of Sun ONE Application Server 7, including PointBase,
then you do not need superuser privileges because only the IDE is installed.

TABLE 1-6 J2SE Software Installer File Names.

Platform Companion CD Directory Installer File Name

Microsoft
Windows

j2sdk\windows j2sdk-1_4_1_02-windows-i586.exe

Linux OS j2sdk/linux j2sdk-1_4_1_02-linux-i586-rpm.bin

Solaris
OS 32-bit

j2sdk/solaris_sparc j2sdk-1_4_1_02-solaris-sparc.tar.Z

Solaris
OS 64-bit

j2sdk/solaris_sparc j2sdk-1_4_1_02-solaris-
sparcv9.tar.Z
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On a Microsoft Windows system, you must have administrative privileges to install
a standard installation of this software. A standard installation includes Sun ONE
Studio and Sun ONE Application Server 7 with PointBase. If you have an existing
installation of Sun ONE Application Server 7, including PointBase, then you do not
need administrator privileges because only the IDE is installed.

If you do not have the proper user privileges or are unfamiliar with installing
software necessitating these privileges, please contact your system administrator for
assistance.
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CHAPTER 2

Installing the IDE
(Microsoft Windows Systems)

This chapter describes how to install the IDE from the product CD or from files
downloaded from the web.

The IDE installer installs Sun ONE Application Server 7, Standard Edition as the
default application server. The application server installation includes the PointBase
Server 4.2 Restricted Edition(PointBase) as part of the standard installation. If you
already have the Sun ONE Application Server 7 installed on your system, a second
copy is not installed.

You can install the IDE in two ways:

■ See “To Install the IDE” on page 22
■ See “Using Command-line Options During Installation” on page 23

Using the GUI Installer
You can install the IDE by using the product CD-ROM or by downloading the
s1s5se-win-en.exe installer launcher from
http://www.sun.com/software/sundev/jde/buy/index.html.

Note – If you encounter errors at any point during the installation, refer to
Chapter 12 for troubleshooting tips.
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▼ To Install the IDE
1. Verify that you have at least the J2SE, version 1.4.1_02 platform installed on your

system and that you have reviewed the space requirements.

See Chapter 1 for details.

2. Start the Installation.

■ To start the install from web download, follow these steps:

a. Log in to your system with administrator privileges.

b. Download the s1s5se-win-en.exe installer file from
http://www.sun.com/software/sundev/jde/buy/index.html and save it
in the s1studio-download-directory.

c. Double-click the s1s5se-win-en.exe file in the s1studio-download-directory.

The Welcome screen appears.

d. Proceed to Step 3.

■ To start the install from the CD-ROM, follow these steps:

a. Log on to your system with administrator privileges.

b. Insert the product CD.

The installer starts and the Welcome page appears. Go to Step 3.

If the installer does not start, the autorun feature might be disabled. Follow these
steps to start the installer:

i. From the Start Menu, choose Run, and browse to the CD-ROM directory.

ii. Double-click the directory installers_se, select
s1s5se-win-en.exe and click Open.

iii. Click OK in the Run dialog box.

The installer starts and the Welcome page appears. Go to Step 3.

3. On the Welcome page, click Next and follow the installer instructions.

The installer asks a series of questions, installs the product, then displays the final
Summary page.

When prompted for the license serial number you have two options:

■ Generate a 60-day trial license serial number by using the 60-day trial button.

■ Use the license serial number listed on a card enclosed in the purchased product
package. If you purchase the product online, then the serial number is provided
to you at the time of purchase and download.
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4. Review the Summary page.

Sun ONE Application Server properties are displayed:

■ Admin Server Host: localhost
■ Admin Server Port: 4848
■ Admin User Name: admin
■ Admin User Password: adminadmin

5. Write down and save the Admin User password.

You need this password to use the Sun ONE Application Server administrative tool.
The other properties can be viewed from within the IDE, by looking at the Sun ONE
Application Server property sheet.

6. Click Finish to exit the installer.

The default installation directory is %Drive%\Sun\studio5_se.

7. Review the log file found at s1studio-install-directory\install.log.

You might see the following message:

The warning is issued because the Microsoft Windows SNMP Service is not installed
on your system. This will not affect the functionality of the IDE. If you have the
SNMP service installed, you should not see this warning.

8. Continue to Chapter 5 for information about setting up the IDE.

Note – If you plan to use Sun ONE Application Server 7, read Chapter 6 before
attempting to deploy your applications.

Using Command-line Options During
Installation
Command-line options for installing in silent mode are supported by the IDE
installers. The procedure depends on whether you are installing from files on the
CD-ROM or files downloaded from the web site. Some command-line options can be
used with the GUI installer.

See Appendix D for details on using the command-line options and for installing in
silent mode.

WARNING - Installation of the SNMP subagent failed
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CHAPTER 3

Installing the IDE
(Linux Systems)

This chapter describes how to install the IDE from the product CD or from files
downloaded from the web.

The IDE installer also installs Sun ONE Application Server 7, Standard Edition as the
default application server. The application server installation includes the PointBase
Server 4.2 Restricted Edition as part of the standard installation.

You can install the Sun ONE Studio 5 IDE in two ways:

■ See “Using the GUI Installer” on page 25
■ See “Using Command-Line Options During Installation” on page 28

Using the GUI Installer
You can install the Sun ONE Studio IDE by using the product CD-ROM or by
downloading the s1s5se-linux-en.bin installer launcher from
http://www.sun.com/software/sundev/jde/buy/index.html.

Note – If you encounter errors at any point during the installation, refer to
Chapter 12 for troubleshooting tips.

▼ To Install the IDE
1. Verify that you have at least the J2SE, version 1.4.1_02 platform installed on your

system and that you have reviewed the space requirements.

See Chapter 1 for details.
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2. Start the installation.

■ To start the install from web download, follow these steps:

a. Download the s1s5se-linux-en.bin installer file from
http://www.sun.com/software/sundev/jde/buy/index.html and save it
in the s1studio-download-directory.

b. Set the execute permission on the s1s5se-linux-en.bin file.

c. Set the DISPLAY environment variable to display to your local system.

For example, if you use the bash shell, type:

d. Become a superuser (root).

Enter your superuser password when prompted.

e. Start the installer.

The Welcome page appears. Proceed to Step 3.

■ To start the install from the CD-ROM, follow these steps:

a. Log in to your system as a superuser using your root password.

To use the CD-ROM and enable the autorun feature to work correctly, log in to
your machine as root. Do not use the su command in a terminal window as this
does not allow you to install correctly when the autorun feature launches the
install process.

b. Insert the product CD.

Answer yes if you are prompted about whether you want to use autorun to install
the CD. Answer yes if you are prompted about whether you want to use autorun.
The Welcome page appears. Proceed to Step 3.

■ If the installer does not start, the autorun feature might be disabled. In this case,
follow these steps:

% chmod a+x /s1studio-download-dir/s1s5se-linux-en.bin

# export DISPLAY=your-local-machine:0.0

%su root

# /studio-download-dir/s1s5se-linux-en.bin
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i. Open a terminal window.

ii. Change to the CD-ROM directory and start the installation.

The Welcome page appears. Proceed to Step 3.

3. From the Welcome page, click Next and follow the instructions on the installer
wizard pages.

The installer asks a series of questions, installs the product, and then displays the
Summary page.

When prompted for the license serial number you have two options:

■ Generate a 60-day trial license serial number by using the 60-day trial button.

■ Use the license serial number listed on a card enclosed in the purchased product
package. If you purchase the product online, then the serial number is provided
to you at the time of purchase and download.

4. Review the Summary page.

The following properties, used by the Sun ONE Application Server, are displayed:

■ Admin Server Host: localhost
■ Admin Server Port: 4848
■ Admin User Name: admin
■ Admin User Password: adminadmin

5. Write down and save the Admin User password.

You need this password to use the Sun ONE Application Server administrative tool.
The other properties can be viewed from within the IDE by looking at the Sun ONE
Application Server property sheet.

6. Click Finish to exit the installation wizard.

Installing as a superuser, the default installation directory is /opt/studio5_se.If
you only installed the IDE and installed it as a standard user, then the default
installation directory is $HOME/studio5_se where $HOME is your home directory.

7. Exit from superuser privileges.

8. Continue to Chapter 5 for information about setting up the Sun ONE Studio 5
IDE.

Note – If you plan to use Sun ONE Application Server 7 to deploy your
applications, read Chapter 6.

# cd /cdrom/en_studiose_5
# ./install.sh
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Using Command-Line Options During
Installation
Command-line options for installing in silent mode are supported by the IDE
installers. The procedure depends on whether you are installing from files on the
CD-ROM or files downloaded from the web site. Some command-line options can be
used with the GUI installer.

See Appendix D for details on using the command-line options and for installing in
silent mode.
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CHAPTER 4

Installing the IDE
(Solaris OS)

This chapter describes how to install your Sun ONE Studio 5 IDE from the product
CD or from files downloaded from the web in supported Solaris operating systems.
It also describes applying the necessary Solaris 8 OS patches using the
solaris_patch_installer script.

The IDE installer installs Sun™ ONE Application Server 7, Standard Edition as the
default application server. The application server installation includes the PointBase
Server 4.2 Restricted Edition as part of its standard installation. If you already have
the Sun ONE Application Server 7 installed on your system, a second is not
automatically installed.

You can install the IDE in two ways:

■ See “Using the GUI Installer” on page 32
■ See “Using Command-Line Options During Installation” on page 35

Before installing the IDE, you need to install the necessary Solaris 8 OS patches.

Applying the Solaris 8 OS Patches
Run the solaris_patch_installer script to ensure that all the Solaris patches
required by the IDE are installed on your system. The patch installer includes the
Solaris patch packages you need for your Solaris 8 OS.

The solaris_patch_installer script is provided on the Sun ONE Studio 5
companion CD and is also available from the Sun ONE Studio 5 product download
page. See “To Install Patches for the Solaris 8 OS” on page 30 for instructions on how
to use the solaris_patch_installer script.

If you do not have the required Solaris patches when you start the IDE installer, a
message displays the Solaris patches that you need. Installing these patches
individually is not recommended. Use the provided solaris_patch_installer
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script. If you are unsure about installing Solaris patches in your Solaris environment,
contact your system administrator. You need to have superuser privileges to install
patches for the Solaris OS.

Note – Some Solaris patches require that you reboot your system after installation
has completed. The installer prompts you to reboot, if necessary.

▼ To Install Patches for the Solaris 8 OS
1. If you have not already done so, download the

solaris_patch_installer.tar.gz file into the solaris-patches-directory from the
Sun ONE Studio download web site at
http://www.sun.com/software/sundev/jde/buy/index.html or from the
Sun ONE Studio 5 companion CD.

Note – Ensure that the solaris-patches-directory on your system has enough available
space to uncompress and extract the contents of the downloaded file. You need at
least 160 MB of free disk space.

2. From the solaris-patches-directory, uncompress and extract the contents of the
downloaded file.

The solaris_patch_installer file and the patches directory are extracted into
the solaris-patches-directory.

3. (Optional) To recover disk space, remove the downloaded file.

4. Become a superuser (root).

Enter your superuser password when prompted.

% cd solaris-patches-directory
% /usr/bin/gzcat solaris_patch_installer.tar.gz | tar xvf -

% rm -rf solaris_patch_installer.tar.gz

% su root
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5. Change to the solaris-patches-directory and run the solaris_patch_installer
script.

The solaris_patch_installer installs the necessary patches.

You see output similar to the following:

This is a sample listing of normal messages and indicate the patch installer script is
running correctly.

6. If prompted, reboot your system.

7. If you are not prompted to reboot, exit from superuser privileges.

8. (Optional) Remove the solaris-patches-directory to recover disk space.

For a complete list of the Solaris patches included with the
solaris_patch_installer script, see Appendix A.

# cd solaris-patches-directory
# ./solaris_patch_installer

# ./solaris_patch_installer
Solaris Patch Installer for J2SE, v.1.4.1
Installing 110380-04...already applied

Installing 110934-10...successfully installed

Installing 112396-02...successfully installed

Installing 108987-13...attempting to patch a package that is not
installed

Installing 111310-01...already applied

# Certain patches installed on your system require that you reboot
your machine.
Do you want to REBOOT your machine now? (y/n)
# y

% rm -rf solaris-patches-directory
Chapter 4 Installing the IDE (Solaris OS) 31



The solaris_patch_installer installs all the necessary patches for the J2SE
platform and those needed for the Sun ONE Studio IDE and its components. Be sure
you have run the patch installer script before trying to install the J2SE platform.

Using the GUI Installer
You can install the Sun ONE Studio IDE by using the product CD or by
downloading the s1s5se-sol-sparc-en.bin installer launcher from
http://www.sun.com/software/sundev/jde/buy/index.html.

Note – If you encounter errors at any point during the installation, refer to
Chapter 12 for troubleshooting tips.

▼ To Install the IDE
1. Verify that you have at least the J2SE, version 1.4.1_02 platform installed on your

system before installing Sun ONE Studio 5 software.

See “Verifying Your J2SE Platform” on page 17.

2. Start the installation.

■ To start the install from web download, follow these steps:

a. Download the s1s5se-sol-sparc-en.bin installer file from
http://www.sun.com/software/sundev/jde/buy/index.html and save
into the s1studio-download-directory.

b. Set the execute permission on the s1s5se-sol-sparc-en.bin file.

c. Set the DISPLAY environment variable to display to your local system.

% chmod a+x /s1studio-download-dir/s1s5se-sol-sparc-en.bin

% setenv DISPLAY your-local-machine:0.0
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d. Enable access to the X server.

e. Become a superuser (root).

Enter your superuser password when prompted.

f. Start the installer.

The Welcome page displays. Proceed to Step 3.

■ To start the install from the CD-ROM, follow these steps:

a. Log in to your system as a superuser using your root password.

To use the CD-ROM and enable the autorun feature to work correctly, log in to your
machine as root. Do not use the su command in a terminal window as this does not
enable you to install correctly when the autorun feature launches the install process.

b. Insert the product CD.

■ On Solaris 8 systems, the installer starts and the Welcome page appears. Go to
Step 3.

■ On Solaris 9 systems, a File Manager window opens when you insert the CD-
ROM. To start the installer, double-click the volstart icon or the install.sh
icon in the File Manager window.

If the installer does not start or you do not see the File Manager window, follow
these steps:

i. Open a terminal window.

ii. Change to the CD-ROM directory and start the installation.

The Welcome page appears. Go to Step 3.

3. From the Welcome page, click Next and follow the instructions on the installer
wizard pages.

% xhost + your-local-machine

%su root

# /studio-download-dir/s1s5se-sol-sparc-en.bin

# cd /cdrom/en_studiose_5
# ./install.sh
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The installer asks a series of questions, installs the product, and then displays the
Summary page.

When prompted for the license serial number you have two options:

■ Generate a 60-day trial license serial number by using the 60-day trial button.

■ Use the license serial number listed on a card enclosed in the purchased product
package. If you purchase the product online, then the serial number is provided
to you at the time of purchase and download.

Note – If you specify a non-default installation directory, do not specify an NFS-
mounted directory. The Sun ONE Application Server 7 cannot be installed on an
NFS-mounted directory.

4. Review the Summary page.

The following properties, used by the Sun ONE Application Server, are displayed:

■ Admin Server Host: localhost
■ Admin Server Port: 4848
■ Admin User Name: admin
■ Admin User Password: adminadmin

5. Write down and save the Admin User password.

You need this password to use the Sun ONE Application Server administrative tool.
The other properties can be viewed from within the IDE by looking at the Sun ONE
Application Server property sheet.

6. Click Finish to exit the installation wizard.

The default installation directory on a Solaris system is /opt/studio5_se.

7. If you enabled client access, disable client access.

8. Exit from superuser privileges.

9. Continue to Chapter 5 for information about setting up the Sun ONE Studio 5
IDE.

Note – If you plan to use Sun ONE Application Server 7, read Chapter 6 before
attempting to deploy your applications.

# xhost - your-machine-name
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Using Command-Line Options During
Installation
Command-line options for installing in silent mode are supported by the IDE
installers. The procedure to use depends on whether you are installing from files on
the CD-ROM or files downloaded from the web site. Some command-line options
can be used with the GUI installer.

See Appendix D for details on using the command-line options and for installing in
silent mode.
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CHAPTER 5

Setting Up the IDE

After you have installed the IDE, use the information in this chapter to start, set up,
and register your software.

This chapter covers the following topics:

■ “Starting the IDE” on page 37
■ “Setting Up the IDE” on page 38
■ “Using the Startup Options” on page 40

Starting the IDE
When you first start the IDE, you are prompted to do the following tasks:

■ Import your customized settings from previous versions
■ Register your software
■ Indicate whether you would like automatic update checking

▼ To Start the IDE (Microsoft Windows Systems)
Use one of these methods:

■ Double-click the Sun ONE Studio SE icon located on your desktop.

■ Choose Start → Programs → Sun Microsystems → Sun ONE Studio SE → Sun
ONE Studio SE.

■ Start the IDE by typing the following command at a command line:

C:\> runidew.exe
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To start the IDE and display messages in the Windows Console, type:

The Windows console displays error messages and other console messages
generated by using the IDE.

Using runidew.exe just starts the IDE. This is the default launcher used by the
desktop icon.

The runide.exe command options can be specified on the command line or in the
s1studio-install-directory\bin\ide.cfg file. See “Using the Startup Options” on
page 40.

▼ To Start the IDE (Solaris or Linux Systems)
1. Change to the s1studio-install-directory/bin directory

The default installation directory is /opt/studio5_se.

2. Start the IDE.

The runide.sh command options can be specified on the command line or in the
s1studio-install-directory/bin/ide.cfg file. See “Using the Startup Options” on
page 40.

Setting Up the IDE
The IDE has the following wizards that enable you to control aspects of the IDE
environment:

■ Settings Import Wizard
■ Registration Wizard
■ Setup Wizard

C:\> runide.exe

% cd /opt/studio5_se/bin

% runide.sh
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Settings Import Wizard
The Settings Import wizard is displayed the first time that you start the IDE. The
wizard enables you to import settings from prior versions of the IDE for use with
Sun ONE Studio 5.

Registration Wizard
The Registration wizard is displayed the first time that you start the IDE. This
wizard enables you to register with the Sun ONE Studio Developer Resources web
site.

Registering your Sun ONE Studio 5 software through the web enables you to do the
following:

■ Use the Update Center to download and install new modules and updates
specific to your environment

■ Subscribe to the Early Access Program (http://forte.sun.com/eap) and
receive new, nonpublic builds of the IDE, as well as preview releases of Sun ONE
Studio 5 modules, patches, and bug fixes

■ Receive product announcements, if desired

If you decide to register with Sun ONE Studio Developer Resources at a later time,
choose Help → Registration Wizard from the main window of the IDE.

Setup Wizard
You can access the Setup wizard from the IDE Welcome screen or by choosing Tools
→ Setup Wizard from the main IDE window.

In the Setup wizard you can do the following:

■ Set the IDE display window mode
■ Specify the web browser to use for internal and external web pages
■ Set the web proxy settings to use if you are behind a firewall
■ Use the Module Installation page to enable or disable IDE modules
■ Use the Update Center page to control the following:

■ Automatic update checking
■ Frequency of automatic updates
■ Update Center URL to check
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▼ To Enable or Disable IDE Modules
1. Choose Tools →Setup Wizard from the main IDE window.

2. Click Next until the Module Installation page is displayed.

3. Expand the module category node for a list of modules.

Click on the module icon to see a short description of the module function.

4. Disable or enable a module by toggling the Enabled property value to true or
false.

By default, all the modules installed with the IDE are enabled except the WebLogic
Server Deployment Module (the WebLogic plugin). For information on enabling this
module, see Chapter 9.

Using the Startup Options
The runide startup scripts can be run with additional command-line options.

You can use the options in the following ways:

■ Type the options on the command line
■ Put the options in the s1studio-install-directory/bin/ide.cfg file

The IDE reads the ide.cfg file before parsing any command-line options. You can
type options on multiple lines in the ide.cfg file.

TABLE 5-1 lists the runide command-line options.

TABLE 5-1 IDE Startup Options

Option Description

-h
-help

Prints a description of the available options and
their usage.

-jdkhome jdk-home-dir Specifies the location of a J2SE platform other
than the default that was specified during
installation.

-cp:p additional-classpath Prepends the specified class path onto the IDE’s
class path.

-cp:a additional-classpath Appends the specified class path to the IDE’s
class path.
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-userdir s1studio-user-directory Specifies the s1studio-user-directory (the location
where your user settings are stored).
If this option is not specified, the default
locaton is used. See the installation chapter for
your platform for more information.

-J jvm-flags Passes specified flags directly to the Java™

Virtual Machine (JVM™) software.

• -Xverify:none -J -Xverify:none tells the JVM software not
to verify the correctness of the bytecode,
thereby providing for faster startup time.
Setting this flag removes some of protection
that the Java language gives you. Refer to the
JVM software documentation for more
information.

• -Xms24m -J -Xms24m sets the initial heap size of the
JVM software to 24 MB. This flag prevents the
JVM software from extending the heap size
during startup, thereby providing a faster
startup time.

• -Xmx96m maximum Java heap size

• -Xss1024k Thread stack size

(Microsoft Windows only) hotspot
or -classic

Specifies the Java virtual machine (JVM) variant
to be used.
The terms “Java virtual machine” and “JVM”
mean a virtual machine for the Java platform.

“-ui” UI_class_name Sets the specified UI class as the IDE’s look and
feel.

“-fontsize” size Sets the font size, expressed in points, in the
IDE’s user interface. The default value is 11.

TABLE 5-1 IDE Startup Options (Continued)

Option Description
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CHAPTER 6

Using Sun ONE Application Server
With the IDE

Once you have successfully installed the IDE, you can complete the configuration of
Sun ONE Application Server as your default application server. This chapter
describes the basic configuration steps necessary to validate your installation and
deploy the example described in Chapter 7. This chapter does not describe all
available configuration options. See the Sun ONE Application Server 7 Getting Started
Guide and the Sun ONE Application Server 7 Administrator’s Guide for more
information. You can find the Sun ONE Application Server 7, Standard Edition
documentation at http://docs.sun.com/db/coll/s1_asse_en.

This chapter covers the following topics:

■ “Understanding Administrative Domains” on page 43
■ “Using the Default Administrative Domain” on page 45
■ “Creating Admininstrative Domains for Each User” on page 47
■ “Using the Sun ONE Application Server 7” on page 52

Understanding Administrative Domains
The Sun ONE Application Server introduces a feature named administrative
domains that enables you to define multiple, completely separate application server
runtime configurations that reuse the same installation image. Each administrative
domain is represented by an administrative server which in turn controls one or
more application server instances. The configuration of an administrative domain
can reside anywhere on the machine.

Although it is likely that developers using their own workstations use a single
administrative domain for day-to-day development, both shared development
servers and operational environments can greatly benefit from using multiple
administrative domains. On shared development servers, creation of an
administrative domain for each developer provides a compartmentalized area or
“sandbox” for each developer on a shared server machine. In operational
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environments, administrative domains enable system administrators to define
separate secure runtime configurations without requiring multiple installations of
the product.

Depending on the engineering practices in your development environment, you
have several options for creating or configuring administrative server domains that
can be used by individual developers.

TABLE 6-1 describes the procedures in this chapter to help you complete the
configuration of Sun ONE Application Server 7.

TABLE 6-1 Sun ONE Application Server Procedures

Description Procedure Reference Permitted User

Start the default administrative
domain that is created and
configured during installation.

See “To Start the Default
Administrative Server” on
page 45

Superuser or
administrator only

Create an administrative domain
for another user to use with the
IDE.

See “To Create a Domain
for Another User” on
page 48

Superuser or
administrator only

Add the user domain to the IDE
server registry.

See “To Add the User’s
Domain to the IDE” on
page 50

All IDE users

Confirm the presence of the
default application server in the
IDE’s server registry.

See “To Confirm the
Default Application
Server” on page 53

All IDE users

Start the Sun ONE Application
Server 7 instance.

See “To Start the
Application Server
Instance” on page 53

All IDE users

Create a user group with
permission to manipulate the
default administrative domain
and server.

See Sun ONE Application
Server 7 Administrator’s
Guide

Superuser or
administrator only

Change permissions on the
domain directories to allow
standard users to manipulate the
default administrative domain
and server.

See Sun ONE Application
Server 7 Administrator’s
Guide

Superuser or
administrator only
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Using the Default Administrative
Domain
This installation of Sun ONE Studio and Sun ONE Application Server 7, creates a
preconfigured default administrative domain. This domain is added to the IDE’s
server registry. By server design, this administrative domain and its associated
administrative server belong to the superuser.

If the users of the IDE normally have superuser or administrator privileges, they can
start the server using the installed default settings. For example, Microsoft Windows
development environments where the developers do their daily work with user
logins that have administrative privileges should use the default administrative
domain and server as described in “To Start the Default Administrative Server” on
page 45.

Additional procedures (not described in this book) for using the default
administrative domain when the standard IDE user does not have superuser or
administrative privileges are:

■ To create a group of users with the permissions that allow them to manipulate the
root-owned default domain.

■ To change permissions on the domain directories, so that standard users can
create their own application server instances and start and stop the default admin
server.

■ To start the default admin server from outside the IDE (this is done by a
superuser) and enable the IDE users to manipulate server instances that belong to
that domain from inside the IDE.

Caution – Changing permissions on the domain directories can create security
problems if not handled properly. See the Sun ONE Application Server 7
documentation for more information.

▼ To Start the Default Administrative Server
This procedure is for a user with superuser or administrative privileges who is
starting the IDE for the first time. If this is not the first time you are starting the IDE,
see “To Confirm the Default Application Server” on page 53.
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1. In the Explorer in the main IDE window, select the Runtime tab.

The Runtime tab of the Explorer displays the Server Registry node. The Server
Registry node contains subnodes for all of the installed web servers and application
servers. There is also a node showing which servers are the default servers.

2. Select the Server Registry node.

A query window pops up, asking whether you want to start the admin server. This
refers to the admin server for the default domain, which can only be run by a user
with superuser or administrator privileges.

3. Click OK.

The IDE starts the default admin server and configures Sun ONE Application Server
as the IDE’s default application server. This process can take a minute or so to
complete.

4. Expand the Server Registry node and expand the Installed Servers node.

5. Expand the Sun ONE Application Server 7 node.

The node localhost:4848 is your Admin Server instance.

6. Expand the localhost:4848 node to see the application server instance server1.
46 Sun ONE Studio 5, Standard Edition Getting Started Guide • June 2003



7. To start your application server instance, right-click server1 and choose Status
from the contextual menu.

The Sun ONE Application Server Instance Status dialog box displays.

8. Click Start Server.

The application server instances starts.

Creating Admininstrative Domains for
Each User
In Solaris and Linux development environments, users do not usually run the IDE as
a user with superuser privileges. If you are planning to use the bundled Sun ONE
Application Server, it is necessary to provide IDE users with access to an
administrative domain that they can start and stop. This enables them to create and
manipulate application server instances within that domain as required by their
development work. There are multiple ways to accomplish this using the default
admin server domain as mentioned in the section “Using the Default Administrative
Domain” on page 45. The procedure described here creates a separate domain for
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each IDE user. Once this is done, each user has the maximum flexiblity for
controlling the use of their admin domain and minimal intervention is required by
the system administrator.

In this procedure, the superuser creates a separate Sun ONE Application Server
administrative domain for each standard user. The standard user completes the
configuration within the IDE by adding (in the Sun ONE Application Server 7
documentation, this is also referred to as “registering”) the administrative domain to
the IDE’s server registry. This enables the standard user to control the administrative
server for this domain and to manipulate instances of the application server as
needed for development.

The procedures documented in this section use the Sun ONE Application Server
asadmin utility, a command-line interface. For more information about the asadmin
utility, see the Sun ONE Application Server 7 Administrator’s Guide at
http://docs.sun.com/source/816-7156-10.

▼ To Create a Domain for Another User
The superuser performs this procedure to create a domain for another user.

1. Become a superuser.

2. Change to the directory where the asadmin utility executable is located.

For example, type:

This example shows the default installation directory for a Solaris installation. If you
specified a different installation directory when you installed this product, replace
/opt/studio5_se with the path name to your installation directory.

# cd /opt/studio5_se/appserver7/bin
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3. In the asadmin utility create the domain with the create-domain command.

The options and associated arguments for this command are described in the
following table. The domain name is specified without an associated option.

The following message displays.

4. Exit from superuser privileges.

5. Provide your standard user with the values that you used in Step 3 for the port
number, admin user name, admin user password, and the domain name.

The standard user uses these values to complete the configuration of the application
server from within the IDE. These values are used in Step 5 in the section, “To Add
the User’s Domain to the IDE” on page 50.

# ./asadmin create-domain --sysuser standarduser --adminport portnumber
--adminuser useradmin --adminpassword userpassword userdomain

Option Argument Description

--sysuser standarduser standarduser is the existing standard
user’s login id for your system.

--adminport portnumber portnumber is an available port number
for this admin domain instance.

--adminuser useradmin useradmin is the user name associated
with this admin domain.

--adminpassword userpassword adminpassword is the user passwor
associated with the user name for this
admin domain.

n/a userdomain userdomain is the standard user’s
domain name and must be unique.

--path domain_path Path to the directory where the domain
should be created. If not specified, the
domian is created in the default
domain directory. See the Sun ONE
Application Server 7 Getting Started
Guide for more information.

Created Domain userdomain successfully.
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▼ To Add the User’s Domain to the IDE
The standard user should perform this procedure.

Note – This procedure is done with the same login and permissions used for
running the IDE for normal day-to-day development activities.

1. Start the IDE.

2. In the IDE Explorer, select the Runtime tab.

3. Select the Server Registry node.

A query window displays asking “Do you want to start the Admin Server now?”
This refers to the default domain, domain1, which can only be run by a superuser or
administrator.

If you click OK, this action creates and starts an admin server that you can not use.

4. Click Cancel.

This dismisses the query window and now we can add your user Admin Server.
This was created by your system administrator or other superuser as described in
“To Create a Domain for Another User” on page 48.

5. Add (also called Register in application server documentation) your admin server
by following these steps:

a. Expand the Server Registry node and expand the Installed Servers node.

b. Right-click the Sun ONE Application Server 7 node and choose Add Admin
Server from the contextual menu.

The Add Admin Server dialog box is displayed.
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c. Type the values in the text fields.

Contact the superuser or administrator who installed the IDE and created your
user admin domain to get these values:

d. Click OK.

The following error message might display:

e. Click OK to dismiss this error message.

The local admin server is started and your new admin server is added to the IDE.
A new admin server node is generated in the Explorer representing your domain
and admin server. You are now ready to create your application server instance.

6. To create the application server instance, follow these steps:

a. In the Explorer, right-click the new admin server node, identified by the
portnumber you entered, and choose Create a Server Instance from the
contextual menu.

The Enter Server Instance Values dialog box is displayed.

Admin Server Host localhost or local machine name

Admin Server Port portnumber used in the create-domain command

User Name useradmin, username used in the create-domain command

User Password userpassword, user password used in the create-domain command

Domain userdomain, used in the create-domain command

Could not connect to Admin Server. If Admin Server is local it will
be started.
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b. Type in a name and an available port number.

For example, MyServer and 4855.

Note – On UNIX systems, the port number 1023 and below are reserved. Use an
available port number above 1023. Do not use port numbers used by the default
application server or by other applications on your system.

c. Click OK.

A new application server instance is created in the IDE. You can see it by
expanding your admin server instance.

7. To set the new server as the default application server and web server, right-click
the new application server instance and choose Set As Default.

8. Expand the Default Servers node to verify.

The default servers for J2EE application and web tier applications show the new
server as the default.

Using the Sun ONE Application Server 7
As long as your admin server is running, you can start, stop and deploy your
applications using your application server instances. When the admin server stops
running, the IDE loses its connection to the application server. If your admin server
is stopped for any reason, for example if your system is rebooted, it is necessary to
start the admin server for your domain and to set the default application server
again.

This chapter describes using Sun ONE Application Server 7 from the IDE. The
application server documentation describes other facilities for starting and stopping
the application server and using the asadmin command-line interface, the
Administrative Console, Windows Services, and other facilities. Refer to the Sun
ONE Application Server 7 Getting Started Guide for more details.
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Note – To use the Administrative Console, you need the admin user password
assigned during installation. The default password is adminadmin, but may have
been changed subsequent to installation. Check with your system administrator.

▼ To Confirm the Default Application Server
If you have started Sun ONE Application Server before, this is how you confirm that
it is still the default server:

1. In the IDE Explorer, select the Runtime tab.

2. Expand the Server Registry node and expand its Default Servers subnode.

If the J2EE Applications node’s label is server-instance(server-hostname:server-
portnumber), then Sun ONE Application Server is the default application server. If it
is not, continue with the next step.

3. Find your server instance under the Installed Servers node, right-click the server
instance, and choose Set As Default.

Your server is set as the default server for J2EE applications and Web Tier
applications.

▼ To Start the Application Server Instance
1. Right-click the application server node and choose Status from the contextual

menu.

Note – If this node is not displayed, your admin server might not be running. Be
sure your admin server is running and then try again.

The Sun ONE Application Server Instance Status dialog box is displayed.
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2. Click Start Server.

If the dialog box has a Stop Server button, the server is already running.

The server is started when the Status line shows Running.

3. Click Close.
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CHAPTER 7

Validating Your IDE Installation

This chapter describes how to validate your installation of the Sun ONE Studio IDE
by showing you how to create a simple web application using Sun ONE Application
Server 7. This chapter covers:

■ “Creating a J2EE Platform Application” on page 55

Note – The following instructions assume that you installed the IDE and the Sun
ONE Application Server 7 and have configured your default application server. See
Chapter 6 for information about configuring the application server.

Creating a J2EE Platform Application
The following steps show you how to create a simple test application for the Java™ 2
Platform, Enterprise Edition Specification (J2EE platform) using Sun ONE Application
Server 7.

1. Create a new directory called helloApp.

2. Start the IDE, if you have not already done so and confirm that Sun ONE
Application Server 7 is your default application server.

See Chapter 6 for more information.

3. Mount the helloApp directory in the IDE by choosing File → Mount Filesystems
from the main window.

The New wizard appears.

a. Select Local Directory and click Next.

b. Select the helloApp directory, and click Finish.

A helloApp node appears in the Filesystems tabbed pane of the Explorer
window.
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4. Create a new Java package named hello.

a. Right-click the helloApp node and choose New → Java package.

The New wizard for a Java package appears.

b. In the New wizard, type the name hello for the new Java package and click
Finish.

A new node for the hello package appears on the Filesystems tabbed pane of the
Explorer window.

5. Create a new session bean named helloTest by doing the following:

a. In the Explorer window, right-click the hello node and choose New → All
Templates.

The New Wizard appears.

b. Expand the J2EE node, choose Session EJB, and click Next.

The New Wizard for a Session EJB appears.

c. Type helloTest in the EJB Name text field, keep all the default settings on the
New wizard, and click Finish.

The helloTest(EJB) node appears in the Filesystems tabbed pane of the Explorer
window. Nodes for helloTest, helloTestBean, and helloTestHome also appear.

6. Add a business method by right-clicking the helloTest(EJB) node and choosing
Add Business Method.

The Add New Business Method dialog box appears.

7. Type sayHello as the method name.

8. Set the return type by selecting java.lang.String from the combo box and
click OK.

9. Edit the sayHello method using the Source Editor:

a. In the Explorer window, expand the helloTest(EJB) node and expand the
Business Methods node.

b. Select sayHello(), right-click, and choose Open.

The Source Editor opens and displays the contents of the helloTestBean
method.

c. Add one line so that the helloTestBean method looks like this:

public java.lang.String sayHello() {
return “Hello there, Studio!”;
}
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10. Choose Build → Compile from the main IDE window or press F9 to compile the
sayHello method.

If no compilation errors are found, the Output Window(Compiler) displays the
message Finished helloTestBean.

11. From the Filesystems tabbed pane of the Explorer window, create a new EJB Test
application by doing the following:

a. Right-click the helloTest(EJB) node and choose Create New EJB Test
Application.

The Create a New EJB Test Application dialog box appears.

b. Accept all the default values by clicking OK.

An EJB module called helloTest_EJBModule, a web module named
helloTest_WebModule, and an application named helloTest_TestApp are
created and automatically mounted in the IDE.

12. In the Filesystems tab of the Explorer window, right-click the
helloTest_TestApp node and choose Execute.

A progress monitor is displayed and the IDE switches to the Running tab. The
helloTest_TestApp is deployed and your web browser appears with the URL
displayed as http://localhost:8000/helloTest_TestApp/dispatch.jsp.

If the browser is not displayed automatically, open it manually and type
http://localhost:8000/helloTest_TestApp for the URL.

Note – Ensure that your web browser is configured to not use proxy servers for
domains beginning with localhost.

If the http://admin-server-host:admin-server-
portnumber/helloTest_TestApp/dispatch.jsp page is displayed, the
application server is working correctly.

You have now verified that your installation of the IDE is working properly with the
Sun ONE Application Server 7.

At this point, you can skip the steps remaining in this chapter or continue to run the
session bean’s method.

13. (Optional) Run the session bean’s method.

a. On the http://admin-server-host:admin-server-
portnumber/helloTest_TestApp/dispatch.jsp page in your web browser,
click the Invoke button next to hello.helloTest create.

The correct button is the first Invoke button on the page, under the heading
Invoke Methods on the hello.helloTestHome. The browser page is refreshed.
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b. In the EJB Navigation section of the browser page, click
hello.helloTest[7].

The number 7 might be some other number in your web browser.

c. Click Invoke next to java.lang.String sayHello.

The page refreshes and section, The Results of the Last Method Invocation
displays the following:

You have completed running the session bean’s method.

Hello there, Studio!

Method Invoked: sayHello()
Parameters:
none
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CHAPTER 8

Using Databases With the IDE

This chapter describes how to configure Java™ DataBase Connectivity (JDBC™)

software. Most of the information pertains to the PointBase Server 4.2 Restricted
Edition (PointBase), which is used with many of the Sun ONE Studio examples and
tutorials. General information about using other databases with the IDE is also
covered.

PointBase is the default database provided as part of the standard Sun ONE Studio
installation. PointBase can be found in the Sun ONE Application Server 7 installation
subdirectory, for example, s1studio-install-directory\appserver7\pointbase.

This chapter covers:

■ “Setting Up PointBase Connectivity” on page 59
■ “Using the PointBase Server and Console” on page 63
■ “Using Other JDBC Enabled Databases” on page 65

Setting Up PointBase Connectivity
An enterprise application uses the JDBC API to interact with a database. Enterprise
applications require pooling of database connections so that the business objects in
the system can share database access. A JDBC data source lets you make connections
to a database. A persistent manager is a component responsible for the persistence of
the entity beans installed in the container. The connection pool, JDBC data source
and JDBC persistent manager are referred to as connectivity resources.

Before you can deploy and execute an enterprise application that uses a database
with Sun ONE Application Server 7, you need to enable the database’s JDBC driver
in the application server environment and create the three connectivity resources.

When the IDE and Sun ONE Application Server 7 are installed together the
following are done for you:
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■ The PointBase JDBC driver is installed automatically.

■ For the Microsoft Windows user with administrator privileges, the IDE installer
also automatically creates the three PointBase connectivity resources to facilitate
use of the IDE’s examples and tutorials. See “To Confirm the PointBase Resource
Configuration” on page 60.

Microsoft Windows users of the IDE who do not have administrator privileges,
Solaris OS users, and Linux OS users who plan to use the Sun ONE Studio examples
and tutorials should follow the procedure, “To Set PointBase JDBC Resources for the
Examples and Tutorials” on page 61 to configure the PointBase resources.

To use the IDE examples and tutorials in cases where you have installed Sun ONE
Application Server 7 independently of your IDE installation, see “To Use an External
PointBase Installation With the IDE” on page 62.

▼ To Confirm the PointBase Resource
Configuration

1. In the Runtime tab of the IDE Explorer, expand the Server Registry node and
expand the Installed Servers node.

2. Expand the default admin server node (localhost:4848) and the default application
server node (server1(localhost:xxxx)).

The variable xxxx = the port number assigned to your application server instance.

3. Expand the registered resources for JDBC Connection Pools, JDBC Data Sources,
and Persistent Mangers.

If the IDE installer was able to configure your PointBase connectivity resources for
the Sun ONE Application Server, you see the following nodes:

■ JDBC Connection Pools: PointbasePool
■ JDBC DataSources: jdbc/jdbc-pointbase
■ Persistent Managers: jdo/PointbasePM
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▼ To Set PointBase JDBC Resources for the
Examples and Tutorials
Users in Solaris and Linux environments, who typically run the IDE without
superuser privileges, need to set the PointBase JDBC resources in the application
server environment. This procedure creates the JDBC connection resources for
running many of the Sun ONE Studio examples and tutorials.

Note – Before starting this procedure, make sure both the admin server and the
application server are running (see “Using the Sun ONE Application Server 7” on
page 52).

1. In the Runtime tab of the IDE Explorer, expand the Server Registry node and
expand the Installed Servers node.

2. Locate your application server instance.

It is labeled app-server-name (app-server-host:app-server-port), for example, MyServer
(localhost:4850).

3. Right-click the application server instance node and choose Preconfigure
PointBase JDBC Resources from the contextual menu.

A timer icon (such as an hour glass) appears. When the process is complete, the
cursor reverts to its usual icon.
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4. Expand the registered resources for JDBC Connection Pools, JDBC Data Sources,
and Persistent Managers.

You should see the following nodes:

■ JDBC Connection Pools: PointbasePool
■ JDBC DataSources: jdbc/jdbc-pointbase
■ Persistent Managers: jdo/PointbasePM

▼ To Use an External PointBase Installation With
the IDE
If you have a PointBase installation external to the IDE, perform the following
actions to connect the IDE to that external PointBase installation. If you do not have
access to a PointBase installation, you must install PointBase before using Sun ONE
Studio examples and tutorials. See the Sun ONE Application Server 7 Getting Started
Guide for instructions on how to install PointBase.

To complete this procedure, you will be writing to the IDE installation directories, so
you must have root or administrator privileges.

1. On your file system, find the PointBase installation directory.

If your system had a pre-existing Sun ONE Application Server 7 installation, then
PointBase may be installed as part of that installation. Look for a pointbase
subdirectory in the s1as7-install-directory.

If you installed PointBase separately from other Sun software, locate your PointBase
installation directory.
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2. In the PointBase installation, locate the pbclientxxx.jar JDBC driver library
file.

3. Copy the pbclientxxx.jar file to the s1studio-install-directory/lib/ext directory.

The PointBase JDBC driver is now enabled.

4. Restart the IDE.

5. In the IDE, choose Tools → PointBase Network Server → Configure.

The Configure PointBase dialog box is displayed.

6. In the text fields, type the PointBase installation directory and server port number;
and click OK.

You can now start your PointBase server and console from the IDE.

7. In the Runtime tab of the IDE Explorer, select your application server instance.

It is labeled app-server-name (app-server-host:app-server-port). For example, the default
server is server1(localhost:80), or a standard user’s server could be MyServer
(localhost:4850).

8. Right-click the application server instance node and choose Properties.

The properties window displays.

9. Open the property editor for the Classpath Suffix property.

Click on the value field of this property, then on the ellipsis button that appears. The
Classpath Suffix editor window is displayed.

10. Click the Add JAR/ZIP button.

Use the Add JAR File file finder to locate your pbclientxxx.jar file.

11. Select the pbclientxxx.jar file and click OK.

12. Click OK to close the property editor window.

The external PointBase JDBC driver for the Sun ONE Application Server 7 runtime is
now located.

Using the PointBase Server and Console
For detailed information on using this database software, see the PointBase
documentation in the s1studio-install-directory/appserver7/pointbase/docs
directory.
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You must start the PointBase database server before you can access a PointBase
database from an application you developed using the IDE or before you can create
your own tables or database with PointBase software.

▼ To Start the PointBase Server

1. From the main IDE window, Choose Tools → PointBase Network Server.

2. Then choose Start Server.

The PointBase 4.2 window appears.

▼ To Stop the PointBase Server

1. From the main IDE window Choose Tools → PointBase Network Server.

2. Then choose Stop Server or choose Server → Shutdown! from the PointBase 4.2
window.

▼ To Start the PointBase Client Console

1. With the PointBase Server running, from the main IDE window choose
Tools → PointBase Network Server.

2. Then choose Start Console.

The Connect to Database dialog box appears.

3. Click OK to continue.

▼ To Stop the PointBase Client Console

Do one of the following:

■ From the Console menu, select File → Exit.

or

■ From the main IDE window, choose Tools → PointBase Network Server → Stop
Console.
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Using Other JDBC Enabled Databases
The following information applies to database drivers other than the driver for the
PointBase Server 4.2 Restricted Edition database.

You can configure Sun ONE Application Server 7 to connect to other databases by
performing actions similiar to those described for PointBase as follows:

■ Enable the database’s JDBC driver
■ Create a connection pool
■ Create a JDBC data source
■ Create a JDBC persistent manager

To enable other JDBC drivers, you must place the database driver files in the
s1studio-install-directory/lib/ext directory before you start the Sun ONE Studio
IDE. If you do not do this, the dbschema wizard does not enable you to select the
proper database driver when you create a new schema. You cannot mount the driver
file in the IDE’s Explorer, nor can you simply place the driver file in the CLASSPATH
environment variable. You must copy the driver file into the lib/ext folder.

For information on configuring the connectivity resources for other databases, see
the Sun ONE Application Server 7 Getting Started Guide. This book can be found at
http://docs.sun.com/db/coll/s1_asse_en.

If you want to use the IDE with an Oracle database, see the Sun ONE Studio 5 J2EE
Application Tutorial found on the Sun ONE Studio Developer Resources portal at:
http://forte.sun.com/ffj/documentation/tutorialsandexamples.html
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CHAPTER 9

Using BEA WebLogic Servers With
the IDE

The standard installation of Sun ONE Studio includes Sun ONE Application Server
7, Standard Edition configured as the default application server. However, you can
use other application servers with the IDE. This chapter describes how to configure
the IDE environment to use WebLogic Servers.

The IDE installation includes support for two versions of the BEA WebLogic servers:
BEA WebLogic Server versions 6.1 SP4 and 7.0 SP2.

This chapter describes:

■ “Configuring the WebLogic Environment” on page 67
■ “WebLogic Support in a Multiuser Environment” on page 71

Configuring the WebLogic Environment
The WebLogic Server Plug-in module is installed with the IDE installation, but is not
enabled. To use BEA WebLogic Server 6.1 or 7.0, you must do the following:

■ Enable the plug-in support for the WebLogic Server version you use, see “To
Enable the WebLogic Server Plug-in Support” on page 68.

■ Set the WebLogic Server as your default application server, see “To Set the
WebLogic Server as the Default Application Server” on page 69.

■ Configure the IDE to start the WebLogic Server, see “To Configure the IDE to
Start the WebLogic Server” on page 70.
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▼ To Enable the WebLogic Server Plug-in Support

Note – Do not have any directories containing J2EE platform components mounted
in the IDE’s filesystem when performing this procedure.

1. Start the IDE.

See Chapter 5 for this information.

2. In the main IDE windows, choose Tools → Setup Wizard.

The Setup Wizard opens and displays the General Sun ONE Studio Settings page.

3. Click Next.

The Module Installation page displays.

4. Expand the J2EE Support node.

A list of modules with version information and whether the module is enabled
appears.

5. Find WebLogic Server Deployment Module and set the Enabled column to True.

6. (Optional, but recommended) If you are not using the Sun ONE Application
Server, disable it by toggling the value in the enabled column to False.

Disabling this unused plug-in support reduces performance overhead while running
the IDE.

7. Click Finish.

The IDE is initially installed with the WebLogic Server 7 support as the default, so
completing this step enables the general WebLogic Server support and creates an
entry for WebLogic Server 7 in the Server Registry.

■ If you are using WebLogic Server 7, continue to “To Set the WebLogic Server as
the Default Application Server” on page 69.

■ To use WebLogic Server 6.1, continue to Step 8.

8. (For WebLogic Server 6.1) To enable the WebLogic Server 6.1-specific plug-in,
follow these steps:

a. Choose Tools → Options.

The Options page displays.

b. Expand the Debugging and Executing node and select WebLogic Plugin
Options entry.

The property sheet values display in the right hand side of the page.

c. Set the WebLogic Server 6 Support property to True.
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d. ((Optional, but recommended) If you don’t intend to use WebLogic Server 7, set
the WebLogic Server 7 Support to False.

Disabling this unused plug-in support reduces performance overhead while
running the IDE.

e. Click Close.

f. Now, continue to “To Set the WebLogic Server as the Default Application
Server” on page 69.

▼ To Set the WebLogic Server as the Default
Application Server

1. In the IDE Explorer window, select the Runtime tab and expand the Server
Registry/Installed Servers node.

The enabled WebLogic Server nodes are visible.

2. Right-click the WebLogic Server node and choose Properties.

The property sheet for the WebLogic server appears.

3. Select the WebLogic Home property.

4. Type the applicable value for the property and close the property sheet. For
example on a Microsoft Windows system, type:

■ bea-install-dir\weblogic700 for WebLogic Server 7.0.
■ bea-install-dir\wlserver6.1 for WebLogic Server 6.1.

Replace the variable bea-install-dir with the pathname to your WebLogic Server
installation directory.

5. Add a WebLogic server instance by right-clicking the appropriate WebLogic
Server node and choosing Add Server Instance.

6. Set the password value in the property sheet by following these steps:

a. Right-click the WebLogic server instance you just created and choose
Properties.

The property sheet for the instance appears.

b. Select the Password property and type the password you specified during the
WebLogic server installation as the property’s value.

c. (WebLogic Server 7 only) Set the RootDirectory property to the location of the
server’s config.xml file.

For example, bea-install-dir/user_projects/mydomain
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d. Close the property sheet.

7. Right-click the WebLogic Server Instance 1 and choose Set As Default Application
Server.

The WebLogic server is now the default application server used by the IDE.

Note – WebLogic Server 7.0 requires that the data sources for CMP beans are
TxDataSources rather than DataSources. This requirement differs from
WebLogic Server 6.1 requirements and is indicated by a message when the
application is deployed to the WebLogic Server 7.0. For more information, see the
BEA web site at http://edocs.bea.com/wls/docs70/faq/jdbc.html.

▼ To Configure the IDE to Start the WebLogic
Server
To start the WebLogic server from the IDE, you must set the Startup Java Options
property.

1. In the IDE, select the Explorer’s Runtime tab.

2. Expand the Server Registry node and expand the Installed Servers subnode.

3. Expand the WebLogic Server node to see the instance nodes.

4. Select the instance you want to change and right-click the WebLogic Server
Instance node and choose Properties.

The Properties window appears for this instance.

5. Locate the Startup Java Options property and enter the following in the text field:

-Djavaplugin.enabled=true

6. (Optional) If needed, specify additional Java class paths or native libraries for the
WebLogic Server using the properties: Extra Class Path and Extra Library Path.

These properties are found on the WebLogic Server property sheet accessed as
described above in Step 4.

7. (Optional) If your WebLogic server uses external resources, such as the examples
PointBase server included with the WebLogic installation, make sure these
resources are available before starting the WebLogic server from the IDE.

The IDE does not automatically detect the external dependency. See Chapter 8 for
details on configuring an external PointBase installation.
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WebLogic Support in a Multiuser
Environment
A command-line configuration script is provided to assist system administrators in
enabling the WebLogic Plug-in support in a multiuser environment. System
administrators setting up a multiuser environment can use the command-line facility
to enable WebLogic Server support and disable Sun ONE Application Server 7 for all
users.

Note – This procedure must be performed before the IDE is started for the first time.

▼ To Enable WebLogic Plug-in Support for a
Multiuser Environment

1. Become a superuser.

2. Change to the IDE installation directory.

On a Solaris system, the default s1studio-install-directory is /opt/studio5_se.

3. Execute the configuration script with the enable option.

4. To disable Sun ONE Application Server 7 on a Solaris system, use the disable
option, for example:

# cd s1studio-install-directory/bin

# ./plugin_config.sh -enable weblogic

# ./plugin_config.sh -disable S1AS
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CHAPTER 10

Upgrading Your Installation

This chapter discusses the following topics:

■ “Updating Modules With the Update Center” on page 73
■ “Using the License Manager Tool” on page 74

Updating Modules With the Update
Center
Once you have the IDE installed on your system, use the Update Center to add new
IDE modules or to update the existing IDE modules.

▼ To Update Your IDE Modules
1. Click the Update Center button from the IDE’s Welcome screen or choose

Tools → Update Center from the main IDE window.

The Update Center wizard appears.

2. Select Sun ONE Studio Update Center as the Update Center, and deselect
NetBeans Update Center.

3. If you haven’t set your proxy configuration, click the Proxy Configuration button.

The Proxy Configuration dialog box displays. Modify the values as needed and click
OK to return to the Update Center wizard.

4. Click Next, and type your Sun ONE Studio Update Center login name and
password.

The Update Center displays the modules that are available to you.
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5. Select individual modules or select all by clicking the >> button.

Use the < button to remove those versions that are not appropriate to your platform.

6. Click Next and follow the Update Center installation procedure.

The IDE installs the selected modules and then restarts itself.

For more information about how the Update Center works andto review Sun’s
privacy policy regarding your personal information, see the Developer Resources
Site FAQs at http://forte.sun.com/ffj/feedback/sitefaq.html.

Using the License Manager Tool
The Sun ONE Studio 5 IDE uses the License Manager tool to enable you to see your
existing license and to upgrade from a trial license serial number to a permanent
serial number. When you install the IDE using a 60-day trial license serial number,
you see warning messages as the expiration date approaches. You can purchase the
product and receive a permanent license serial number at any time during the 60-
day trial period.

You may view your license information or upgrade to a permanent serial number
using the License Manager by using the following procedures.

▼ To View the Status of Your License
While you are in the trial period, you can view how many days are remaining by
using the License Manager tool.

1. Choose Tools → License Manager from the main IDE window.

The License Manager appears.

2. Click on the Serial Number Reporting tab.

The Serial Number Reporting page appears. You can review the serial number
information and see if it is a trial or permanent license and how many days remain
until the expiration date.
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▼ To Upgrade to a Permanent License
Follow this procedure to upgrade to a permanent serial number at any time during
your trial period. After your 60-day trial has expired, trying to start the IDE will
cause this same Serial Number Installation page to appear. You can enter the new
permanent serial number at that time. You receive a permanent serial number when
you purchase the product.

Note – You must install the permanent serial number using the same user privileges
as when the IDE was installed. For example, on Solaris, the installation must be done
as a root user, therefore you must be running the IDE as a root user to upgrade the
license serial number.

1. Become a superuser or log in to your system with administrator privileges.

Contact your system administrator if you did not install the IDE yourself.

1. Start the IDE.

2. Choose Tools → License Manager from the main IDE window.

The License Manager appears.

3. Click on the Serial Number Installation tab.

The Serial Number Installation page appears.

4. Enter the permanent serial number in the text box and click Install.
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CHAPTER 11

Uninstalling the IDE

An uninstaller wizard is available to remove the Sun ONE Studio 5 IDE. You must
uninstall the IDE and the Sun ONE Application Server with the same user privileges
required during the installation. On a Solaris or Linux system, you must be a
superuser. On a Microsoft Windows system, you must have administrative
privileges.

This chapter describes how to uninstall each of the supported platforms:

■ For Microsoft Windows systems, see “To Uninstall the IDE (Microsoft Windows
Platform)” on page 77.

■ For Linux systems, see “To Uninstall the IDE (Linux Systems)” on page 79.

■ For Solaris OS, see “To Uninstall the IDE (Solaris OS)” on page 80.

Using the Uninstaller

▼ To Uninstall the IDE (Microsoft Windows
Platform)
Use the Microsoft Windows Add/Remove utility to uninstall in the Windows
operating environment.

1. Exit and shut down the IDE before starting this procedure.

2. Ensure that you have at least J2SE version 1.4.1_02 available on your system.

3. Choose Start > Settings > Control Panel.

The Control Panel dialog box appears.
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4. Double-click Add/Remove Programs.

5. Select Sun ONE Studio 5, Standard Edition from the list of currently installed
programs.

6. Click Change/Remove.

The InstallShield Wizard prepares the uninstaller wizard and the Welcome panel
appears.

7. Click Next and follow the instructions.

When the uninstallation is complete, the final Summary panel appears.

8. Click Finish.

9. Check the s1studio-install-directory.

A successful uninstallation leaves the following files and folders:

s1studio-install-directory

install.log

uninstall.log

s1studio-install-directory\appserver7

statefile

uninstall.exe

uninstall.log

s1studio-install-directory\appserver7\bin

icudt2.dll

icuin2.dll

icule2.dll

icuuc2.dll

s1studio-install-directory\appserver7\bin\lib

s1studio-install-directory\appserver7\bin\share\bin

If your s1studio-install-directory/appserver7 directory contains other files, you
might have installed add-on products or the uninstallation might be incomplete. See
“Identifying and Fixing an Incomplete Uninstallation” on page 95 for more
information.

Note – The s1studio-user-directory is not deleted during uninstallation.

10. Examine the s1studio-install-directory\uninstall.log file for error messages.

11. If the uninstallation was successful, you can delete the remaining directories and
files.
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▼ To Uninstall the IDE (Linux Systems)

Caution – You must use the Sun ONE Studio uninstaller to uninstall this software
from your Linux system. Do not attempt to use rpm -e commands to uninstall the
IDE. Failure to use the uninstaller might result in a corrupted system.

1. Exit and shut down the IDE before starting this procedure.

2. Ensure that you have at least J2SE version 1.4.1_02 available on your system.

3. Set your display environment variable to display to your local machine.

For example, if you use the bash shell, type:

4. Become a superuser.

5. Start the uninstaller wizard.

The uninstaller’s Welcome screen appears.

6. Click Next and follow the instructions.

The uninstaller wizard uninstalls the IDE.

7. Click Finish.

8. Check the s1studio-install-directory.

A successful uninstallation leaves the following directories and files:

s1studio-install-directory

uninstall.log

install.log

s1studio-install-directory/appserver7

uninstall

statefile

uninstall.log

s1studio-install-directory/_uninst

If your s1studio-install-directory/appserver7 directory contains other files, you
might have installed add-on products or the uninstallation might be incomplete.

% export DISPLAY=your-local-machine:0.0

# java -jar /s1studio-install-directory/_uninst/uninstall.jar
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Note – The s1studio-user-directory is not deleted during uninstallation.

9. Examine the s1studio-install-directory/uninstall.log file for error messages.

If you suspect your uninstallation was incomplete, see Chapter 12 for information
about fixing a failed uninstallation.

10. If the uninstallation was successful, you can delete the remaining directories and
files.

Use this command to remove the log files and the installation directory only. Do not
attempt to uninstall the product files using this command. You must run the
uninstaller successfully before removing these log files and the directory in which
they reside.

11. Exit from superuser privileges.

▼ To Uninstall the IDE (Solaris OS)

Caution – Use the Sun ONE Studio uninstaller to uninstall this software from your
Solaris system. Do not attempt to use rm -r or pkgrm commands to uninstall the
IDE. Failure to use the uninstaller might result in a corrupted system.

1. Exit and shut down the IDE before starting this procedure.

2. Ensure that you have at least J2SE version 1.4.1_02 available on your system.

3. Enable client access to the X server by typing:

4. Set your display environment variable to display to your local machine.

5. Become a superuser (root).

# rm -r s1studio-install-directory

% xhost + your-machine-name

% setenv DISPLAY your-machine-name:0.0
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6. Start the uninstaller wizard.

The Welcome screen appears.

7. Click Next and follow the instructions.

The uninstaller wizard uninstalls the IDE.

8. Click Finish.

9. Check the s1studio-install-directory.

A successful uninstallation leaves the following directories and files:

s1studio-install-directory

uninstall.log

install.log

s1studio-install-directory/appserver7

uninstall

statefile

uninstall.log

s1studio-install-directory/_uninst

If your s1studio-install-directory/appserver7 directory contains other files, you
might have installed add-on products or the uninstallation might be incomplete.

Note – The s1studio-user-directory is not deleted during uninstallation.

10. Examine the s1studio-install-directory/uninstall.log file for error messages.

If you suspect your uninstallation was incomplete, see Chapter 12 for information
about fixing a failed uninstallation.

11. If the uninstallation was successful, delete the remaining directories and files. :

Use this command to remove the log files and the installation directory, only. Do not
attempt to remove the product files using this command. You must run the
uninstaller successfully before removing these log files and the directory in which
they reside.

# java -jar /s1studio-install-directory/_uninst/uninstall.jar

# rm -r s1studio-install-directory
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12. Disable client access and exit from superuser privileges.

# xhost - your-machine-name
# exit
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CHAPTER 12

Troubleshooting Problems

This chapter provides tips for how to troubleshoot problems that you might
encounter in the following areas:

■ “Installing Solaris 8 OS Patches With the solaris_patch_installer” on
page 84

■ “Installing the IDE” on page 85

■ “Starting the IDE” on page 90

■ “Using Start Menu Items (Microsoft Windows Platform)” on page 91

■ “Running Web Services” on page 92

■ “Running Web Services Using UDDI” on page 94

■ “Using WebLogic Server 6.1 or 7.0” on page 95

■ “Identifying and Fixing an Incomplete Uninstallation” on page 95
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Installing Solaris 8 OS Patches With the
solaris_patch_installer
TABLE 12-1 describes problems you might encounter using the
solaris_patch_installer script.

TABLE 12-1 solaris_patch_installer Problems

Problem Solution

You get an error message similar to the following after
running the solaris_patch_installer on a
newly installed Solaris 8 OS:
# ./solaris_patch_installer

Solaris Patch Installer for J2SE, v.1.4.1
Installing 109147-14... successfully
installed
Installing 108434-06...

...

Installing 108773-12... pkgadd failed
Cannot continue patch installation.
For more details, please look at
/var/tmp/solaris_patch_installer.log

Run the solaris_patch_installer script a
second time. If you continue to have problems,
contact your Solaris system administrator.
This error can occur if you have a more recent
revision of a patch on your system than the one that
is included in the script. The script does not install
the older patch version. In rare cases, the subsequent
patch that the script tries to install has an explicit
dependency on that older patch. When this situation
arises, it will be necessary to examine the specific
patches on the system and use the patches listed in
Appendix A to decide what to do. This task is best
done by an experienced system administrator.
Remember, the order in which the
solaris_patch_installer installs the patches
is important. The patches are installed in the order
listed in Appendix A.
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Installing the IDE
TABLE 12-2 describes problems you might encounter during the IDE installation.

TABLE 12-2 Sun ONE Studio 5 IDE Installation Problems

Problem Solution

You get an error message while installing
the Sun ONE Studio 5 IDE:
Error writing file = There may
not be enough temporary disk
space. Try using -is:tempdir to
use a temporary directory on a
partition with more disk space

Start the installer using -is:tempdir command-line option to
specify a directory with more space. Don’t specify a directory
on an NFS-mounted filesystem. Don’t specify a directory using
a symlink.
For example, in a Solaris operating environment, type the
following at the command prompt:
$ s1s5se-sol-sparc-en.bin -is:tempdir
temporary-directory

The installer fails and displays a message
that there is not enough available disk
space to use for installation. However, the
file system you specified for installing the
IDE has plenty of available disk space.

Determine if the filesystem you specified is symbolically linked
to another file system whose disk space is not recognized. For
example, in a Solaris environment, /export/home has 2 GB of
space and / has 100 MB. The /opt directory is symbolically
linked to /export/home. If you specified /opt/s1studio as
the IDE installation directory, the Sun ONE Studio 5 installer
does not recognize the symbolic link to /export/home. The
installer recognizes only the / directory, which is the target
directory for /opt and has only 100 MB.
To correct the problem, directly specify the filesystem with the
larger available disk space as the installation directory.

You get the following error message while
installing the Sun ONE Studio 5 IDE:
Error: Could not find JVM

Start the installer with the -is:javahome command-line
option, to specify where the J2SE platform is installed.
For example, in a Solaris OS, type the following at the
command prompt:
s1s5se-sol-sparc-en.bin -is:javahome java-home-
directory

(UNIX only) The installer looks like it has
hung. No messages are displayed.

• Check that the DISPLAY environment variable is set correctly.
If you are installing on your local system, the DISPLAY
environment variable should be set to your-machine-
name:0.0.

• Check that you have enabled access to the X server with the
command xhost + your-machine-name.

See Chapter 3 for Linux systems installation and Chapter 4 for
Solaris OS installation.
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(Solaris OS only)
ERROR: could not initialize
interface awt - exception:
java.lang.NoClassDefFoundError
java.lang.NoClassDefFoundError at
java.lang.Class.forName0(Native
Method) at
java.lang.Class.forName(Class.jav
a:130

...

Wizard.getExitCode(): called
after WizardServices is shutdown.

Wizard.getExitCode(): called
after WizardServices is shutdown.

This error indicates that your DISPLAY environment variable is
not set correctly. In some cases, you need to make sure that it
includes the domain as well as the host name. For example:
setenv DISPLAY your-machine-name.your-domain:0.0

The IDE installer exits without installing
the product. No messages are displayed.

• The file you downloaded from the Sun ONE Studio product
download page is not complete. Download the file again and
check that the size of the downloaded file is the same as the
file size specified on the product download page. Run the
IDE installer again.

• You have specified an invalid command-line parameter in the
installer-name.sp file. Check the file and correct the
command-line options. Run the IDE installer again. See
Appendix D.

• Run the installer launcher (installer-name.exe file or installer-
name.bin file) with the option -is:log log.txt, where
installer-name is the specific installer file name for your
platform. Check log.txt for possible errors. See
Appendix D.

(Solaris OS only) While attempting to
install using remote CD drive, the following
error is seen in the CD Mount Support
dialog box:
No CD found. Please insert Sun
ONE Studio 5 CD.

You are attempting to install from a remote CD drive mounted
through NFS. NFS is not supported. You should invoke
installation directly from the remote CD drive. You must still
have the proper J2SE platform version installed on the local
machine. Run the Solaris installer from the following location:
CD-mount-
path/en_studiose_5/installers_se/s1s5se_sol-
sparc-en.bin

The -is:tempdir command-line option is
not working.

Ensure that you are using the correct syntax for the command-
line option. For example, in a Solaris environment, the syntax is
as follows:
s1s5se_sol-sparc-en.bin -is:tempdir
temporary-directory.
Don’t specify a directory on an NFS-mounted filesystem.

TABLE 12-2 Sun ONE Studio 5 IDE Installation Problems (Continued)

Problem Solution
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You get an error message that says that the
product is not supported for the Solaris 7
OS after you inserted the product CD on a
computer running in the Solaris 7 operating
environment.

The Sun ONE Studio 5 IDE is only supported for the Solaris 8
and Solaris 9 OS.

(Solaris OS only) You get the following
error message:
ERROR: cannot find
product/product.xml on your
computer.

Stop and restart the volume management process (vold) on
your system, and run the installer again.
1. Ensure that CD-ROMs or floppy disks are not being used. If

you are not sure whether you have found all users of the
media, run the fuser command.

2. Become superuser.
3. Stop volume management.
# /etc/init.d/volmgt stop

4. Restart volume management.
# /etc/init.d/volmgt start

(Solaris OS only) Not able to eject the
product CD after running the installer
manually.

After running the installer manually, change out of the CD-
ROM directory before trying to eject the CD-ROM from the
drive. The CD-ROM is not ejecting because the system is
detecting that the CD is being used.

(Linux RedHat 7.2 only) During
installation, the installer componenet panel
displays the message:
The installation of Sun ONE
Application Server 7 with
PointBase is not supported on
your platform.

Linux RedHat 7.2 is a supported platform. However, if you
have modified the /etc/redhat-release system file, the
installer cannot recognize your platform as valid.
The installer is looking for the value “Red Hat Linux release
7.2” in the system file.

TABLE 12-2 Sun ONE Studio 5 IDE Installation Problems (Continued)

Problem Solution
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(Solaris OS) After inserting the CD, the
installer started but displayed the following
message:
The installation cannot continue
for the following reason(s): To
install Sun ONE Studio 5 you need
to log in as superuser or a user
with administrator privileges.

You are logged in as a standard user without the appropriate
permissions to install this product. Do one of the following:
Method one:
1. Click Finish on the installer wizard page.
2. Open a terminal window and type eject cdrom.

3. Log out of your system.
4. Log in to your sytem as a superuser. .
5. Reinsert the CD.

Method two:
1. Open a terminal window.
2. Enable access to the Xserver by typing xhost + your-machine-

name.
3. Set the DISPLAY environment variable to your local machine

by typing, for example: setenv DISPLAY your-machine-
name:0.0

4. Become a superuser.
5. Change to the CD-ROM directory. Type:
cd /cdrom/en_studiose_5

6. Invoke the installer. Type:
./install.sh

7. When the installation is finished, disable the Xserver by
typing xhost -, then exit from superuser privileges.

If you do not have the proper login permissions, contact your
system administrator.

(Solaris OS only) During installation, you
see this error message: J2SDK packages
SUNWj2rt or SUNWj3rt are missing
on your system. you must install
a valid package-based JDK
1.4.1_02 (or later) before
running this installer.

Some of the default Java packages on your Solaris OS have been
removed. You must install a package-based J2SE platform that
meets the minimum requirements. See Chapter 1 for more
details.

TABLE 12-2 Sun ONE Studio 5 IDE Installation Problems (Continued)

Problem Solution
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(UNIX systems) The installer Summary
panel indicates that your installation was
successful, but when you review the
install.log file, you see the following
error: Setup.product.install,
com.sun.installer.

InstallApplicationServerAction,
err, Error occured while

installing [0] ->
/s1studio-install-directory/appserver_ins
t/install.sh

/s1studio-install-directory/appserver_ins
t statefile ../install.log where
s1studio-install-directory is an NFS-
mounted filesystem.

This error occurs on UNIX systems if you specify an NFS-
mounted filesystem as the installation directory. As a result of
this error, the IDE has been installed, but not Sun ONE
Application Server 7.
For best results, it is recommended that you uninstall the IDE,
then reinstall the IDE specifying a local filesystem directory for
your installation directory. See Chapter 11.
If necessary, also see “Identifying and Fixing an Incomplete
Uninstallation” on page 95 for additional help.

(Microsoft Windows) After exiting the
installer or uninstaller wizard, you see the
WindowsNativeToolkit process
consuming a large percentage of your CPU
resources.

The WindowsNativeToolkit process is started during
installation and uninstallation. Sometimes it does not stop
properly. Use the Windows Task Manager to find any instances
of the process WindowsNativeToolkit and end the process.

(Solaris OS) The installer Summary panel
indicates that installation was successful,
but when you review the install.log
file, you see the following error:
Installing Appserver...

Existing Sun ONE Message Queue
3.0 installation has been
detected. Silent installation
cannot proceed. Please consult
Installation Guide for upgrade
information.

Can't write statefile
“s1studio-install-directory/appserver7/st
atefile"
:java.io.FileNotFoundException:
“s1studio-install-directory/appserver7/sta
tefile (No such file or
directory)

(date-time) Finished Installing
Appserver7...

This indicates that the Sun ONE
Application Server was not installed.

This problem occurs if you try to install Sun ONE Studio 5 on a
system that already has Sun™ One Message Queue 3.0 software
installed. This has caused the Sun ONE Application Server 7
installation to fail and only the IDE has been installed. To fix
this problem, follow these steps:
1. Uninstall Message Queue 3.0 using the pgkrm utility. See the

Sun ONE Message Queue Installation Guide at
http://docs.sun.com/source/816-5928-10/index.h
tml for details on uninstalling this software.

2. Uninstall the IDE. See “To Uninstall the IDE (Solaris OS)” on
page 80.

3. Reinstall Sun ONE Studio 5.

TABLE 12-2 Sun ONE Studio 5 IDE Installation Problems (Continued)

Problem Solution
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Starting the IDE
TABLE 12-3 describes problems you might receive during startup and configuration of
the newly installed IDE.

TABLE 12-3 Sun ONE Studio 5 Startup and Configuration Problems

Problem Solution

When starting the IDE, you get an error
message similar to the following:
ERROR: The J2SE[tm] 1.2.1 found
at /usr/java1.2/bin/java cannot
be used by the IDE. J2SE[tm]
1.4.1_02 is recommended.
NOTE: You can download and
install the J2SE[tm] and related
Solaris[tm] patches from
http://access1.sun.com/forte/.

Warning: Current runtime
environment does not satisfy
minimum requirements.

The values of the $JAVA_PATH and $JDK_HOME environment
variables override the value of the J2SE platform path you
specified during the IDE installation. You need to unset these
environment variables or use the -jdkhome command-line
option when starting the IDE. See Chapter 5.

You experience performance problems
running the IDE.

Increase your virtual memory or swap space to 1.5 to 2 times
the amount of your machines’s installed RAM.
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Using Start Menu Items
(Microsoft Windows Platform)
TABLE 12-4 describes errors you might receive using the Start menu items on
Microsoft Windows to access documentation, examples and tutorials, or other items
that take you to a web page. These errors are due to the way Microsoft Windows is
interpreting your browser settings.

TABLE 12-4 Start Menu Errors (Windows)

Problem Solution

Error message appears when you select one
of the IDE Start Menu items that take you to
a web page. For example:
Error: Cannot find the file C:\
Sun\studio5_se\docs\
documentation.html. Make sure the
path and filename are correct and
that all required libraries are
available.

This error is a Microsoft Windows error that occurs when using
a Netscape browser. If you have Netscape set as the program to
open HTML pages, but you don’t set Netscape as your default
browser, you may see this error.
Click OK to dismiss the error.

To solve this problem, set Netscape as your default browser, or
set Internet Explorer as the program to open HTML pages.

A subsequent error message appears after
dismissing the one described above.
Error: Unable to run this
command.

Click OK to dismiss this error.
Set Netscape as your default browser.
Chapter 12 Troubleshooting Problems 91



Running Web Services
TABLE 12-5 describes error messages you might get when running a web service using
any of the application servers supported by the IDE.

TABLE 12-5 Errors When Running a Web Service With Any Application Server

Problem Solution

[java.rmi.RemoteException: HTTP
transport error:
java.net.ConnectException:
Connection refused; nested
exception is: HTTP transport error:
java.net.ConnectException:
Connection refused

• Changes were made to the web service, and you did not
refresh the web service client that was making the call to
the web service. To refresh the web service client:
Right-click the web service client node and select Refresh
From Web Service. from the contextual menu. This
regenerates the client proxy to reflect the changes made to
the web service.

• After you developed and deployed your web service, you
changed the target deployment server and you did not
change the web service SOAP RPC URL. To fix this:

1. Change the SOAP RPC URL property found on the web
service property sheet.

2. Right-click the web service node and choose Generate Web
Service Files.

3. If you have a default client, right-click it and select Refresh
From Web Service.

4. Redeploy the web service.
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[java.rmi.RemoteException:cannot
connect to server:Not found;

nested exception is: cannot connect
to server: Not found

The Web Context property of the web module in the J2EE
application does not match the context root specified in the
SOAP RPC URL property of the web service. To view the
Web Context property of the web module:
1. Expand the J2EE application to which the web service was

added.
2. Right-click the web module of the web service (the file

whose name ends in _War) and choose Properties.
3. The Web Context property is one of the properties

displayed in the Properties window.
To view the context of the SOAP RPC URL property of the
web service:
1. Right-click the web service node and choose Properties.
2. The SOAP RPC URL property displays a value that is

similar to the following:
http://localhost:8000/MyService/MyService

The first instance of MyService in this URL is the context
root or web context. You can change it to any value of your
choice, but it must match the value of the Web Context
property of the web module in the J2EE application.

TABLE 12-5 Errors When Running a Web Service With Any Application Server (Continued)

Problem Solution
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Running Web Services Using UDDI
TABLE 12-6 describes error messages you might get when running a web service using
UDDI.

TABLE 12-6 Errors When Running a Web Service Using UDDI

Problem Solution

You get an empty web page when viewing
.wsdl files.

Many versions of the Netscape web browser do not display the
.wsdl file. View the page’s source file to see the actual .wsdl
file.

You get the following exception when
searching for anything in a UDDI registry
using the New Client wizard:
IllegalArgumentException

If you intend to use a public UDDI registry, set the User Proxy
Server name and port information in the IDE.
• Choose Tools → Setup Wizard from the main window of the

IDE and provide the User Proxy Server name and port.
You must restart the IDE for the values to take effect.

The internal UDDI registry server fails to
start and displays the following exception:
jjava.lang.RuntimeException:
RegistryServerSevlet.initializeDB(
...):

com.sun.xnode.XNodeException:
aborting connection attempt.,

RegistryServerServlet.init(...):
connection: 1, Database failed to
connect

A possible cause is that a previous Xindice server instance was
not terminated properly. (On a Microsoft Windows system, you
might have to restart the operating system to get rid of these
server instances.)
1. Terminate the corresponding Java processes associated with

that Xindice server instance.
2. Restart the IDE.
Always terminate the internal UDDI registry server using the
following steps:
1. Select the Runtime tab of the Explorer.
2. Expand the UDDI Server Registry node.
3. Right-click the Internal UDDI Registry and choose Stop

Server from the contextual menu.
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Using WebLogic Server 6.1 or 7.0
TABLE 12-7 describes error messages you might get when using WebLogic Server 6.1
or 7.0.

Identifying and Fixing an Incomplete
Uninstallation
If the IDE uninstaller wizard quits before all the product files are deleted, some files,
directories, and other system entries are not properly uninstalled.

You can identify a failed uninstallation in the following ways:

■ Examining the directories and files remaining after you uninstall the IDE
indicates that not all files were deleted properly. See Chapter 11 and refer to the
section for your platform for a list of files that are not deleted during
uninstallation.

TABLE 12-7 Errors When Using WebLogic Server 6.1 or 7.0

Problem Solution

WebLogic server is unable to download its
XML document definitions from the BEA
web site.

If you deploy a J2EE application client to the WebLogic server,
the server must be able to download its XML document
definitions from the WebLogic web site. If your connection to
the web requires a proxy server, specify this setting in the IDE
before deploying an application to the WebLogic server. To set
the proxy server, choose Tools → Setup Wizard and specify
your proxy and web browser settings.

When executing a J2EE application you see
the following error:
Error configuring application
listener of class
...<.JAXRPCContextListener>

java.lang.ClassNotFoundException:
...<JAXRPCContentListener>

You started the WebLogic server from outside the IDE. Please
see “To Configure the IDE to Start the WebLogic Server” on
page 70 to start the server from the IDE.
If you must start the server from outside the IDE, add the
following to the WebLogic class path environment variable. For
example, on a Microsoft Windows system, the path t add is
s1studio-install-directory\jwsdp\jwsdp-common-lib\jwsdp-
common.jar. See WebLogic documentation for more
information if needed.
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■ After uninstalling the product, you are unable to reinstall the same or a newer
version even though you are using a different installation directory or you have
deleted the old one. This problem might indicate a corrupted product registry.

■ You see an error message while uninstalling the IDE, the uninstall process fails, or
the log contains an indication that the uninstallation failed.

If you have a failed uninstallation you might encounter problems if you try to
reinstall the same or different versions of the IDE or if you try to install a stand-
alone version of Sun ONE Application Server 7.

If you used an uninstallation method other than the provided uninstaller wizard,
you might be left with an incomplete or corrupted uninstallation. The following
sections describe what to do to fix your system if you determine that you have an
incomplete uninstallation. You can also visit the Knowledge Base at the Sun ONE
Studio Developer Resources portal at the following URL: http://forte.sun.com/ffj.

▼ To Fix a Failed Uninstall (Microsoft Windows
Platform)

1. Be sure you are logged in as a user with administrator privileges.

2. Locate the application server uninstaller in your s1studio-install-directory.

The default installation directory is %SystemDrive%\Sun\studio5_se.If this
executable is not present, continue to Step 4.

3. Run the application server uninstaller and continue to Step 4.

4. Stop the WindowsNativeToolkit processes and remove corresponding files.

a. Use the Windows Task Manager to find any instances of the process
WindowsNativeToolkit and end the process.

b. Delete the WindowsNativeToolkit file found at %TEMP%\
WindowsNativeToolkit_version-id.exe.

5. Use the wincleanup.exe utility to remove services corresponding to the default
domain and any instances you created.

C:\> s1studio-install-directory\appserver7\uninstall.exe
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a. Locate the wincleanup.exe utility at s1studio-install-directory\appserver7\bin\
wincleanup.exe.

If the utility is not at this location, you can download it from
http://forte.sun.com/ffj. Look underneath the heading IMPROVING
PRODUCTIVITY.

b. Run wincleanup.exe to remove the default domain services.

c. Repeat Step b for any additional domains or server instances you have created,
using the service (domain or server) name as an argument.

6. Using the Windows Registry Editor, delete the following folder and its contents
from the Windows Registry:

HKEY_LOCAL_MACHINE\SOFTWARE\Sun Microsystems\Application Server

7. Remove the following key and its contents:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\CurrentVersion\Uninstall\
Sun ONE Application Server 7

8. Remove the application server entries from the productregistry file located at
%SystemRoot%\system32\.

9. Remove the Start Menu Program Group named Sun Microsystems > Sun ONE
Application Server 7 and its contents (Program Items).

10. Remove the Start Menu Program Group named Sun Microsystems > Sun ONE
Studio 5 SE and its contents.

11. Remove the product files from the s1studio-install-directory.

12. Reboot the system so that the system comes up with a clean registry.

▼ To Fix a Failed Uninstall (Solaris OS)
1. Enable client access to the X server.

C:\> s1studio-install-directory\appserver7\bin\wincleanup.exe

C:\> s1studio-install-directory\appserver7\bin\wincleanup.exe service-name

% xhost + your-local-machine
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2. Set the DISPLAY environment variable to display to your local system.

For example, if you use the C shell, type:

3. Become a superuser.

4. Open the Solaris Product Registry tool.

5. Expand the System Registry node and choose the Sun ONE Application Server
node.

6. Click Uninstall and follow the instructions.

7. Remove the remaining files in the s1studio-install-directory.

Note – Remove the program files and directories as the last step in this procedure.

The following Solaris packages are installed by the IDE installer:

■ SUNWasaco
■ SUNWascmo
■ SUNWasdbo
■ SUNWasdmo
■ SUNWasdvo
■ SUNWaslco
■ SUNWaso
■ SUNWaspx
■ SUNWasro

Use this list as a reference to be sure you removed all of them. It is recommended
that you only remove these packages manually if the uninstaller wizard and the
Solaris Product Registry tool failed to remove them.

8. Disable client access to the X server and exit from superuser privileges.

% setenv DISPLAY your-local-machine:0.0

# /usr/bin/prodreg &

# rm -r s1studio-install-directory

# xhost - your-local-machine
# exit
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▼ To Cleanup a Failed Uninstall (Linux Systems)
1. Become a superuser.

2. Query for installed application server rpm packages.

You see some or all of the following packages:

■ SUNWasaco-7.0.0-0.0.0
■ SUNWaso-7.0.0-0.0.0
■ SUNWtls-3.3.2-0.0.0
■ SUNWxsrt-7.0.0-0.0.0
■ SUNWjhrt-7.0.0-0.0.0
■ SUNWascmo-7.0.0-0.0.0
■ SUNWjaxp-7.0.0-0.0.0
■ SUNWxrgrt-7.0.0-0.0.0
■ SUNWasdmo-7.0.0-0.0.0
■ SUNWicu-7.0.0-0.0.0
■ SUNWasro-7.0.0-0.0.0
■ SUNWjaf-7.0.0-0.0.0
■ SUNWxrpcrt-7.0.0-0.0.0
■ SUNWpr-4.1.2-0.0.0
■ SUNWjmail-7.0.0-0.0.0
■ SUNWaclg-7.0.0-0.0.0
■ SUNWasdbo-7.0.0-0.0.0

3. Remove any of the 17 packages listed above that appear in the output from the
command in Step 2

4. Check for installed Message Queue packages.

5. If found, as illustrated in Step 4, remove theMessage Queue packages.

# rpm -qa | grep SUNW

# rpm -e package-name

# rpm -qa | grep imq
# imq-3.0.1-01

# rpm -e imq-3.0.1-01
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6. Rename /var/tmp/productregistry to
/var/tmp/productregistry.BACKUP.

7. Remove the following directories, using the rm -rf command:

■ /var/opt/imq
■ /etc/opt/imq
■ /var/opt/SUNWappserver7
■ /etc/opt/SUNWappserver7
■ /tmp/*admin*
■ /tmp/*domain*
■ /tmp/*server*

8. Remove the s1studio-install-directory.

9. Exit from superuser privileges.

$ rm -rf /s1studio-install-directory
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APPENDIX A

Solaris 8 OS Patch Numbers and
Descriptions

TABLE A-1 provides the patch numbers and patch descriptions included with the Sun
ONE Studio 5, Standard Edition solaris_patch_installer for the Solaris 8 OS.
These patches must be installed in the order that they are listed in this table. For this
reason, the solaris_patch_installer script is the recommend method for
installing these patches on your system.

TABLE A-1 Patch Numbers and Descriptions for Solaris 8 OS

Patch Identification Number Patch Description

110380-04 ufssnapshots support, libadm patch

110934-10 pkgtrans, pkgadd, pkgchk and libpkg.a patch

112396-02 /usr/bin/fgrep patch

108987-13 Patch for patchadd and patchrm

111310-01 /usr/lib/libdhcpagent.so.1

111293-04 /usr/lib/libdevinfo.so.1

111111-03 /usr/bin/nawk patch

108528-20 SIGEMT

111023-02 /kernel/fs/mntfs and
/kernel/fs/sparcv9/mntfs patch

110386-03 RBAC Feature Patch

108989-02 Accounting

108652-66 Xserver

112003-03 Fontset

111308-03 /usr/lib/libmtmalloc.so.1 patch
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You can also find additional information about these patches at the SunSolve Patch
Support Portal at http://sunsolve.Sun.com/pub-cgi.

109326-09 security, libresolv poll()

109147-22 Solaris 8 interprocedural optimizer

108993-18 LDAP2 Patch

108940-51 Motif 1.2.7 and 2.1.1: Runtime library patch for Solaris 8
OS

108921-16 CDE 1.4 dtwm

108773-17 X input methods

TABLE A-1 Patch Numbers and Descriptions for Solaris 8 OS (Continued)

Patch Identification Number Patch Description
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APPENDIX B

Port Usage in the IDE

TABLE B-1 provides a listing of the ports used by the Sun ONE Studio IDE. It includes
ports used bythe IDE modules, third-party components, and application servers that
are used with the IDE. Also included is information on whether the default port
assignment can be modified.

If you are using multiple application servers or you are using the IDE in a multiuser
environment, you might encounter port conflicts. If you encounter a port conflict,
consult this table for information about how to modify the port assignment.

TABLE B-1 Port Usage in the Sun ONE Studio 5, Standard Edition IDE

Module, Application
Server, or Third-Party
Component

Default
Port
Number
Assigned Description How to Modify the Default Port Assignment

NetBeans Open File
Module

7318 Open file
server

1. Choose Tools → Options in the main IDE window.
2. Expand the IDE Configuration node.
3. Expand the Server and External Tool Settings node.
4. Right-click Open File Server, and choose Properties from

the contextual menu.
5. Select Port property and type a different port number.

NetBeans Internal
HTTP Server
Module

8082 Embedded
server HTTP

The default port assignment is automatically changed if a
conflict is detected.

PointBase Restricted
Edition

9092 In the IDE, Choose Tools → PointBase → Configure, and
set the port number.
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Internal JWSDP
Tomcat

8015 Server
adminis-
tration

1. In the Runtime tab of the Explorer, expand the Server
Registry node and expand the Installed Servers node.

2. Expand the Tomcat 4.0 node, right-click the Internal
JWSDP node, and choose Properties from the contextual
menu.

3. Select the Server Port property and type the desired port
number.

8081 Server HTTP 1. In the Runtime tab of the Explorer, expand the Server
Registry node and expand the Installed Servers node.

2. Expand the Tomcat 4.0 node and expand the relevant
installation node.

3. Right-click the node representing the Host to be edited,
and choose Properties from the contextual menu.

4. Select the HTTP Connector property field and type the
desired port number.

8443 Redirecting Modify
s1studio-user-dir/JWSDP_base/conf/server.xml.
Be aware that you edit the server.xml file at your own
risk. Be sure to create a backup version of your working
server.xml file before beginning to edit.
1. On the Runtime tab of the Explorer, expand the Tomcat

4.0 node under the Installed Servers node.
2. Right-click the node for the installation of Tomcat that

you want to edit. From the contextual menu, choose
Configure (server.xml).

The server.xml file appears in the Source Editor. You can
now edit server.xml to modify the default port number.

11555 IDE
debugger
connection

1. In the Runtime tab of the Explorer, expand the Server
Registry node and expand the Installed Servers node.

2. Expand the Tomcat 4.0 node, right-click the
InternalJWSDP node and choose Properties from the
contextual menu.

3. Select the Debugger tab.
4. Select the Debugger Port property and type the desired

port number.

TABLE B-1 Port Usage in the Sun ONE Studio 5, Standard Edition IDE (Continued)

Module, Application
Server, or Third-Party
Component

Default
Port
Number
Assigned Description How to Modify the Default Port Assignment
104  Sun ONE Studio 5, Standard Edition Getting Started Guide • June 2003



Java Web Services
Developer Pack
UDDI Server
(bundled with the
IDE)

8095 Tomcat
server port
for registry
server

1. Open the
s1studio-install-directory/jwsdp/uddi_base/conf/ser
ver.xml file in a text editor.

2. Replace the port number.
3. Restart the IDE.

8089 Tomcat
HTTP port
for registry
server

1. Open the
s1studio-install-directory/jwsdp/uddi_base/conf/ser
ver.xml file in a text editor.

2. Replace the port number.
3. Restart the IDE.

4080 Xindice
HTTP

1. Open the
s1studio-install-directory/jwsdp/tools/xindice/conf
ig/system.xml file in a text editor.

2. Replace the port number.
3. Restart the IDE.

WebLogic 6.1 or 7.0 7001 Server HTTP The default port assignment can be modified during the
installation of the WebLogic server. When using WebLogic,
verify that the WebLogic Server instances in the Runtime
tab of the IDE Explorer have the correct value for the Port
property.

7002 Server
HTTPS

The default port assignment can be modified during the
installation of the WebLogic server. When using WebLogic,
verify that the WebLogic Server instances in the Runtime
tab of the IDE Explorer have the correct value for the Port
property

Sun ONE
Application Server 7
Solaris Integrated
and Solaris
Supported Edition

4848 Server
administra-
tion HTTP

Refer to the server installation documentation
(http://docs.sun.com/source/816-7145-
10/index.html) for details.

80 HTTP web
server

Refer to the Sun ONE Application Server 7 Getting Started
Guide and the Sun ONE Application Server 7 Standard Edition
Installation Guide for details. You can find the Sun ONE
Application Server 7 documentaton at
http://docs.sun.com/db/coll/s1_asse_en

TABLE B-1 Port Usage in the Sun ONE Studio 5, Standard Edition IDE (Continued)

Module, Application
Server, or Third-Party
Component

Default
Port
Number
Assigned Description How to Modify the Default Port Assignment
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APPENDIX C

IDE Subdirectories

This appendix describes the subdirectories that are installed in the
s1studio-install-directory. It also describes the user directory created during
installation that is used by the IDE for user-specific information.

Installation Subdirectories
TABLE C-1 describes the subdirectories that can be found in the IDE
s1studio-install-directory. On Solaris and Linux systems, additional directories are
used for the installation of Sun ONE Application Server 7. See Sun ONE Application
Server 7 Standard Edition Installation Guide available at
http://docs.sun.com/db/coll/s1_asse_en for more details.

TABLE C-1 Sun ONE Studio 5 Installation Subdirectories

Subdirectory Description

_uninst Contains the files used to uninstall the IDE.

appserver_inst Information files related to Sun ONE Application Server 7
installation.

appserver7 Contains the Sun ONE Application Server 7 files.

bin Contains contains the IDE startup and utility
executables, IDE configuration, security policy.

docs Contains the Sun ONE Studio 5 help files and other miscellaneous
documentation.

examples Contains source files for examples that illustrate several key
features of the Sun ONE Studio 5 software.
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IDE User Subdirectory
The IDE stores user-specific data in the user directory. Examples of this informaton
are IDE settings and options and other necessary runtime data for personal
development servers, such as the PointBase Server, UDDI Registry Server and
Tomcat. The user directory also contains the ide.log file, which provides useful
information when requesting technical support.

■ The default location for this directory on a Microsoft Windows system is C:\
Documents and Settings\user-id\studio5se_user.

■ On a Solaris or Linux system, the default location is $HOME/studio5se_user.

The minimum space requirement for this directory for initial installation is 5.5 MB.
Actual usage will vary depending on your component use within the IDE.

jwsdp Contains files and directories specific to the Java Web Services
Developer Pack.

lib Contains the JAR files that make up the IDE’s core
implementation and the open APIs.

modules Stores Sun ONE Studio 5 modules as JAR files.

sources Contains sources for libraries that might be redistributed with
user applications.

system Contains files and directories used by the IDE for special
purposes.

update_tracking Contains information used by the Update Center.

TABLE C-1 Sun ONE Studio 5 Installation Subdirectories (Continued)

Subdirectory Description
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APPENDIX D

Command-Line Options for
Installing the IDE

This appendix describes the command-line options for installing the IDE. There are
four main reasons for using command-line options.

■ To specify a non-standard location for the J2SE platform, see “Specifying the
Location of the J2SE Platform” on page 110

■ To specify a non-standard location for the temporary space directory, see
“Specifying the Location of the Temporary Space Directory” on page 111

■ To specify a log file for error messages to aid in debugging, see “Specifying a
Log File for Error Messages” on page 111.

■ To install in silent mode, see “Installing the IDE in Silent Mode” on page 111.
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Command-Line Options Used With the
GUI Installer
Three command-line options can be used with the GUI installer files. TABLE D-1
summarizes these option.

Specifying the Location of the J2SE Platform
■ If the installer does not detect your J2SE platform (this can happen if your J2SE

platform is installed in a non-standard location), you can invoke the installer from
the command line using the option -is:javahome to specify the path to your
J2SE platform.

■ For example, on a Microsoft Windows system, type this command:

Replace the variable j2se-directory with the location of your J2SE installation.

TABLE D-1 Command-line Options Used with Gui Installers

Option Description

-is:tempdir pathname Specifies the directory to use for temporary space. Used
when the default on your system has insufficient space for
the installer to run successfully.

-is:javahome pathname Specifies the locations of your J2SE platform. Useful when
the J2SE platform is installed in a non-standard location.

-is:log log.txt Directs the installer to put error messages into the log file,
log.txt.

C:\> \s1studio-download-directory\s1s5se-win-en.exe -is:javahome C:\j2se-
directory
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Specifying the Location of the Temporary Space
Directory
If the default temporary space directory does not have enough space to run the
installer, you can invoke the installer from the command line using the option -
is:tempdir to specify another directory that has sufficient space.

Specifying a Log File for Error Messages
If you need to do additional troubleshooting during a problem installation, you can
run the installer with the -is:log log.txt option. This directs the installer to put
error messages in the file log.txt.

Installing the IDE in Silent Mode
You can run the installer in a non-interactive mode, called silent mode, by specifying
the -silent option on the command line. This option suppresses GUI displays to
the terminal window. The procedure for installing the IDE silently (in a non-
interactive mode) depends on whether you are installing from files on the CD-ROM
or files downloaded from the web site.

■ If you downloaded the installer files from the web site, you create a file
containing the command-line install options and use the installer launchers. The
installer launcher and the options file must reside in the same directory. See
“Installing Silently Using Web Download” on page 112.

■ If you have the CD-ROM, you type the options on the command line and start
installer jar files. The jar files are only available on the CD-ROM. See
“Installing Silently Using the CD-ROM” on page 115.

C:\> \s1studio-download-directory\s1s5se-win-en.exe -is:tempdir C:\
temporary-directory

C:\> \s1studio-download-directory\s1s5se-win-en.exe -is:log log.txt
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Installing Silently Using Web Download
Create a file containing the command-line options you want to use and place the file
in the s1studio-download-directory. Then invoke the installer from the command line
using the -silent option. The following example shows the steps for installing the
IDE silently from the command line on a Solaris OS.

▼ To Install Silently From Web Download (Solaris OS)

1. In a text editor, create the s1s5se-sol-sparc-en.sp file in the s1studio-download-
directory where you saved the downloaded s1s5se-sol-sparc-en.bin installer
launcher.

Include at least the three mandatory options and remember to put them in quotes.
For example, your .sp file might look like this:

See TABLE D-2 for other install options.

installDir=”/opt/studio5_se”
jdkHome=”/usr/j2se”
serialNumber=”trial”

TABLE D-2 Command-Line Options for Silent Installation

Option - Short
Name Option - Long Name Description

id installDir Specifies the directory where you want the IDE
installed. Mandatory for -silent mode.

jh jdkHome Sets the location of the valid J2SE version to use
with the IDE. Mandatory for -silent mode.

sn serialNumber Sets the license serial number for the IDE.
Mandatory for -silent mode.
112  Sun ONE Studio 5, Standard Edition Getting Started Guide • June 2003



2. Enable client access to the X server.

Replace your-machine-name with the host name of your machine.

3. Set your display environment variable to display to your local machine.

4. Become a superuser (root).

5. Start the installer launcher from the command line.

-np noPointBaseFound Specifies what to do if Sun ONE Application Server
7 is already installed.
The value “useExistingAppserver” tells the
installer to continue the installation of the IDE even
though an existing installation of the application
server has been detected.
The value “reinstall” tells the installer to exit if an
existing installation of Sun ONE Application Server
7 without PointBase Server is detected.
This option is only useful if Sun ONE Application
Server 7 without PointBase Server is already
installed on the system.

ps proxyServer Specifies with the -DportNumber option the
registry setting for the proxy server name and port
number.

pn portNumber Specifies with -DproxyServer option the registry
setting for the proxy server name and the port
number. These options can be set at any time using
the IDE.
Specifying these two options on the command line
is optional. However, if specified, they are both
required. These options canalso be set at any time
using the Setup wizard in the IDE . See Chapter 5.

% xhost + your-machine-name

% setenv DISPLAY your-machine-name:0.0

# cd s1studio-download-directory
# s1s5se-sol-sparc-en.bin -silent

TABLE D-2 Command-Line Options for Silent Installation (Continued)

Option - Short
Name Option - Long Name Description
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The installer uses the options specified in the s1s5se-sol-sparc-en.sp file to
install the IDE and displays the following in the command prompt window:

6. When the installation completes, review the log file install.log found in the
s1studio-install-directory.

7. Disable client access and exit from superuser privileges.

▼ To Install Silently From Web Download (Microsoft
Windows)

The following example shows the steps for installing the IDE silently from the
command line on a Microsoft Windows system.

1. In a text editor, create the s1s5se-win-en.sp file in the
s1studio-download-directory where you saved the downloaded s1s5se-win-en.exe
installer launcher.

Include these mandatory options and remember to put them in quotes. For example,
your .sp file might look like this:

See TABLE D-2 for other install options.

2. Start the installer launcher from the command line.

InstallShield Wizard
Initializing InstallShield Wizard...
Searching for Java(tm) Virtual Machine...
.........
Running InstallShield Wizard...

# xhost - your-machine-name
# exit

installDir=”C:\Sun\studio5_se”
jdkHome=”C:\j2sdk1.4.1_02”
serialNumber=”trial”

C:\> cd s1studio-download-directory
C:\> s1s5se-win-en.exe -silent
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The installer uses the options specified in the s1s5se-win-en.sp file to install the
IDE and displays the following in the command prompt window:

Installing Silently Using the CD-ROM
If you have the product CD-ROM, you can use the installer jar files and type your
options directly on the command line. To install using the jar file, type your
installation options on the command line with the -silent option. Include the
three mandatory options. This procedure can not be used with the .bin installer
launcher downloaded from the web site.

When the options are typed directly on the command line, the installer uses the Java
global variable specification option (-D) to pass information to the installer script.

For example, on a Microsoft Windows system, type the following in a command
prompt window:

In this example:

■ -Did is the install directory to use
■ -Djh specifies the J2SE location
■ -Dsn indicates to the installer to generate a trial serial number
■ D: is the CD-ROM drive containing the product CD.

On a Solaris OS system, type the following:

InstallShield Wizard
Initializing InstallShield Wizard...
Searching for Java(tm) Virtual Machine...
.........
Running InstallShield Wizard...

C:\> java -Did=”C:\s1studio-install-directory” -Djh=”C:\j2sdk1.4.1_02”
-Dsn=”trial” -jar D:\installers_se\s1s5se-win-en.jar -silent

# cd /cdrom/en_studiose_5/installers_se
# java -Did=”s1studio-install-directory” -Djh=”/usr/j2se” -Dsn=”trial” -
jar s1s5se-sol-sparc-en.jar
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Remember to enclose the values in quotes. See TABLE D-3 for a list of otions.

TABLE D-3 Command-Line Installation Options

Option - Short
Name Option - Long Name Description

-Did -DinstallDir Specifies the directory where you want the IDE installed.
Mandatory command-line parameter when using -silent mode.

-Djh -DjdkHome Sets the location of the valid J2SE version to use with the IDE. The
installer configures the IDE to use this J2SE.
Mandatory command-line parameter when using -silent mode.

-Dsn -DserialNumber Sets the license serial number for the IDE.
Mandatory command-line parameter when using the -silent
mode.

-Dnp -DnoPointBaseFound Specifies what to do if Sun ONE Application Server 7 is already
installed.
The value “useExistingAppserver” tells the installer to continue the
installation of the IDE even though an existing installation of the
application server has been detected.
The value “reinstall” tells the installer to exit if an existing
installation of Sun ONE Application Server 7 without PointBase
Server is detected.
This option is only useful if Sun ONE Application Server 7 without
PointBase Server is already installed on the system.

-Dps -DproxyServer Specifies with the -DportNumber option the registry setting for the
proxy server name and port number.

-Dpn -DportNumber Specifies with -DproxyServer option the registry setting for the
proxy server name and the port number. These options can be set at
any time using the IDE.
Specifying these two options on the command line is optional.
However, if specified, they are both required. These options canalso
be set at any time using the Setup wizard in the IDE . See Chapter 5.
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The following table lists the installer file names for the three platforms.

TABLE D-4 Installer and Command-Line Options File Names

Type of File Microsoft Windows Linux Solaris OS

Web installer
launcher

s1s5se-win-en.exe s1s5se-linux-en.bin s1s5se-sol-sparc-en.bin

CD-ROM installer
launcher

s1s5se-win-en.exe s1s5se-linux-en.bin s1s5se-sol-sparc-en.bin

jar file (CD only) s1s5se-win-en.jar s1s5se-linux-en.jar s1s5se-sol-sparc-en.jar

Command-line
options file (use with
installer file only)

s1s5se-win-en.sp s1s5se-linux-en.sp s1s5se-sol-sparc-en.sp
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Index
A
admin server, 43

adding, 50
starting, 45
stopping, 52

admin user password, 23, 27, 34, 49, 53
administrative domains

creating, 47
default, 43
defined, 43

application server
confirming default, 53
default, 43, 70
starting, 50
WebLogic, 67

asadmin utility, 49

C
classpath

option for starting IDE, 40
command-line options

install, 23, 28, 35
installing silently, 111
javahome, 110
log, 111
mandatory, 112, 115
starting the IDE, 40
tempdir, 85, 111

ConnectException error, 92

D
databases

connecting to Sun ONE Application Server 7, 63
Oracle, 65
troubleshooting, 94
using with the IDE, 59

default admin user password, 23, 27, 34, 53
default application server, 43
deploying applications, 59
directories

default Linux installation, 38
default Solaris installation, 38
default Windows installation, 23
IDE user, 41, 108
installation subdirectories, 107
left after uninstalling, 78, 79, 81

documentation
PointBase, 63
related, 9 to 12
Sun ONE Application Server 7, 44, 48, 107

E
enabling

modules, 40
error message log option, 111
example applications

PointBase resources, 61
subdirectory, 107
where to download, 11
119



F
failed uninstallation

determining Linux systems, 79
determining Solaris OS systems, 81
determining Windows systems, 78
fixing, 95

FileNotFoundException error, 89

H
helloStudio test application, 55

I
IDE modules

enabling, 40
updating, 73

IDE settings
font size, 41
importing, 39
look and feel, 41

IllegalArgumentException error, 94
installer problems

cannot continue error, 88
exits without installing, 86
hangs, 85
packages missing error, 88

installing the IDE
command-line options, 111
in silent mode, 111
Linux, 25
Microsoft Windows, 22
options, 112
Solaris, 32

J
J2SE platform

archived versions, 17
determining, 18
installing, 18
javahome option, 110

java.lang.NoClassDefFoundError error, 86
Javadoc technology, 11
JAXRPCContentListener error, 95

JDBC API
enabling drivers, 63
setting up connectivity, 59

L
license

finding, 22, 27, 34
trial, 74
upgrading, 75
viewing, 74

license manager tool, 74
Linux

space requirements, 16
supported platforms, 14

logging option, 111

M
Microsoft Windows

space requirements, 16
supported platforms, 14

modules
enabling, 40
updating, 73

N
NoClassDefFoundError error, 86

P
password

See admin user password
patch installer script

troubleshooting, 84
using, 29

patches, Solaris 8 OS, 29, 101
PointBase

classpath, 63
command-line option, 113
enabling external installation, 62
starting, 64
stopping, 64
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user data location, 108
using with WebLogic, 70

port numbers
admin server default, 23, 27, 34
IDE usage, 103 to 105
proxy server, 113

previous releases, supporting, 19
product.xml file error, 87
proxy configuration, 39, 73

R
Registration wizard, 39
release notes, 10
RemoteException error, 92, 93
runide, 38
runide.sh, 38
runidew, 38

S
serial number

command-line option, 112
finding, 22, 27, 34
upgrading, 75
viewing, 74

Settings Import wizard, 39
Setup wizard, using, 39
shared server, 43
silent mode installation, 111
Solaris 8 OS patches

applying, 29
identifying, 101
installer script, 30
troubleshooting, 84

Solaris OS
space requirements, 17
supported platforms, 14

space requirements
Linux, 16
Microsoft Windows, 16
Solaris OS, 17
temporary space, 16
to improve performance, 90
troubleshooting, 85

user directory, 108
standard installation, defined, 19
starting the IDE

Linux systems, 38
Microsoft Windows, 37
Solaris OS, 38

startup options, 40
Sun ONE Application Server 7

Administrative Console, 52
disabling, 68
starting, 50

supported platforms, 14
system requirements, 14

T
temporary space, requirements, 16
trial license, 74
tutorials, enabling PointBase resources, 61

U
uninstalling the IDE

Linux, 79
Solaris, 80
troubleshooting, 95
Windows, 77

unsupported platform error, 87
update center, 39
updating modules, 73
upgrading

to permanent license, 75
user directory

specifying, 41
user settings, 19, 39

W
web browser, 39
web proxy settings, 39
WebLogic

enabling plug-in, 68
external PointBase, 70
Java class paths, 70
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multiuser environment, 71
native libraries, 70
password, 69
setting as default, 69
starting, 70
troubleshooting, 95

wizards
Registration, 39
Settings Import, 39
Setup, 39

X
XNodeException error, 94
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